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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License types
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note,
unless otherwise stated, that each Instance of a product must be
separately licensed and ordered. For example, if the end user
customer or Avaya Channel Partner would like to install two
Instances of the same type of products, then two products of that
type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE

AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
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All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
This document describes how to use the IP Office Contact Center User Interface for Windows.
The focus of this document is primarily on agent and supervisor functionality, but high-level
information about administration functionality is also provided. Detailed administration information
for the IP Office Contact Center User Interface for Windows is available in separate documents.

Note:

The online help version of this document in the IP Office Contact Center build might not be the
latest version. Obtain the final version from http://support.avaya.com/. For information about
finding documents, see Finding documents on the Avaya Support website on page 127.

Change history

Issue Date Summary of changes
Release
10.1,
Issue 1

May 2017 • Added a note in the “Introduction” chapter indicating that the latest
version of this document is available at http://support.avaya.com/.

• Added information about Realtime Information elements and
values.

• Updated Performing spell checks on page 52 to indicate that you
must perform a spell check if your administrator has enabled
automatic spell checks.

• Added a note to Entering a job code on page 40 indicating that if
the call has more than one job code, the system saves only the
first value.

• Added Redirecting or picking up a call or a chat conversation on
page 96.

• Added information about chat transfer and consultation.

• Rephrased a few sentences for clarity throughout the document.
Table continues…
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Issue Date Summary of changes
Release
10.1.1,
Issue 2

October 2017 • Removed IP Office Contact Center User Interface for Chrome
Devices references. Other names for this interface include
“Chrome App” and “Chrome UI”. All of these references have been
removed.

• Added Updating notification settings on page 13.

• Listed a new menu item in Menu bar on page 19.

• Updated a note in Entering a job code on page 40.

• Added Performing chat spell checks on page 62 and Setting the
language for spell checks on page 63.

• Updated Exporting reports on page 110.

• Updated Agent status report data on page 119 and Contact detail
report data on page 119.

Release
10.1.2,
Issue 3

April 2018 • Updated Interface tabs on page 15.

• Updated Break policies and restrictions on page 32 to indicate
that an administrator can choose to allow breaks during sign off
prevention.

• Updated Telephony on page 34.

• Updated “About this task” in Working with wrap up or ACW time on
page 39.

• Updated Requesting support during a call on page 39.

• Updated an option in Qualifying a call as incorrect on page 41.

• Updated the sections under Email navigation on page 43

• Updated Email reporting on page 103.

• Abbreviated the information in Agent status report data on
page 119.

• Updated Contact detail report data on page 119.

• Added the icon image for the new viewer in Additional details on
page 121.

• Updated Documentation on page 124.

• Minor rephrasing throughout the document.

Introduction
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Chapter 2: Getting started with the IP Office
Contact Center User Interface
for Windows

The IP Office Contact Center User Interface for Windows is the switchboard for all actions in the IP
Office Contact Center system. The following user roles exist:

• Agents: Perform customer service tasks, such as making and receiving telephone calls. If
configured, agents can also communicate using email and instant messaging chats.

• Team leader: Monitor the activities that agents perform in real time and historical reporting.

• Supervisors: In addition to monitoring agent activities, supervisors can also create, view, and
edit reports and real time information in the interface. The reports that supervisors work with
include historical reports for telephony, email, or chat.

• Administrators: Perform system administration, such as configuring email and chat services,
and creating and editing topics, objects, call flows, and scripts. Administrators can also access
supervisor functionality.

The functionality that an agent can access depends on the privileges that the administrator has
assigned to that agent. Supervisors can generally access Supervision and Agent functionality.

For a description of each module you can access in the IP Office Contact Center User Interface for
Windows, see Interface tabs on page 15.

Logging in to the user interface
Procedure

1. On your Windows computer, open the IP Office Contact Center User Interface for
Windows.

2. On the Loginscreen:

a. In User name, enter your agent, supervisor, or administrator user name.

b. In Password, enter your password.
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Note:

After three failed login attempts, you are locked out for a predefined time. You can
ask your administrator to reset your password to unlock your user ID. By default,
the lockout time is set to 60 seconds and you can attempt to log in 3 times before
you are locked out. The lockout time can be changed by an administrator in the IP
Office Contact Center User Interface for Windows Configuration module.

c. (Optional) If you want to use telephony functionality, in Telephone extension, type
the telephone extension number.

Next steps
Sign in to your agent groups.

Related links
Agent groups and profiles on page 30

Logging out of the user interface
About this task
Use this procedure to log out of the UI when your work shift ends. After you log out, you cannot
receive calls until you sign in to your agent groups again.
You cannot log out while you are on an active call. The system automatically signs you out of all
agent groups if you do not answer an incoming call in the required time.

Procedure
1. On the status bar, click .

2. Click Log out.
3. Click Close ( ) to exit the UI.

Changing your password
About this task
Your password must consist of at least 8 characters from two or more of the following groups:

• Lower case letters
• Capital letters
• Numbers
• Special characters (!, @, #, $, %, ^, &, *)

Getting started with the IP Office Contact Center User Interface for Windows
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Before you begin
Ensure that you have the required privilege to change passwords.

Procedure
1. Click File > Change password.

2. In the Change Password window, do the following:

a. Enter your old password.

b. Enter your new password and confirm it.

3. Click OK.

Changing your alias
About this task
An alias or pseudo-name is used for anonymous statistics.

Before you begin
Ensure you have the required privileges to change your alias.

Procedure
1. Click File > Change alias.

2. In the Change Alias window, type your new alias.

3. Click OK.

Updating notification settings
About this task
Use this procedure to update the notification settings that are displayed when the UI is minimized
or hidden. The notification options that you can set depend on what your administrator has
configured in the Configuration module.

Before you begin
You must have the “Change audio/visual notification” privilege.

Procedure
1. Click File > Change audio/visual notifications....
2. To enable notifications, select one or both of the following options and then click OK:

• Audio

Changing your alias
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• Visual

Important:

You can only set the options that your administrator has configured in the
Configuration module.

Accessing help files
About this task
Use this procedure to access help files.

Procedure
Do one of the following:

• On the menu bar, click Help > Contents.

• On the keyboard, press F1.

Searching help files
Procedure

1. On the Help menu, click Contents.

2. In the Online help dialog box, click the Search tab.

3. Enter key words, and click List Topics or press Enter.

4. To display the selected topics, select a topic and click Display.

Getting started with the IP Office Contact Center User Interface for Windows
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Chapter 3: Navigation

Interface tabs
You can access IP Office Contact Center modules from:

• The Go to menu.

• The Agent, Supervision, and Administration tabs.

The following sections describe the Agent, Supervision, and Administration tab options in more
details.

Agent tab
The following image shows the Agent tab with the email and chat features configured. The Email
and Chat buttons do not appear on the tab unless an administrator has configured these features.

April 2018 Using Avaya IP Office Contact Center for Windows 15
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows 


Number Button Description
1 Home Displays the main Home screen for the interface. You can view

supervisor messages and general statistics from this screen.
You can also sign in to and out of agent groups and start or
end breaks.

2 Telephony Enables you to perform telephony operations and access
telephony statistics.

3 Email Enables you to send, receive, and organize emails. This button
only appears if your administrator has configured the email
feature.

4 Chat Enables you to communicate with customers using IM. This
button only appears if your administrator has configured the
chat feature.

Supervision tab
Supervisors can access agent functionality as well as the options available in the Supervision tab.

Navigation
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Number Button Description
1 Realtime information Enables you to monitor objects and agents in real time.

Objects that are updated periodically cannot be monitored in
real time. You can monitor the following objects in real time:

• Topics

• Agents

• Agent groups

• Teams

• IVR
2 Reporting Enables you to view and create different types of reports.
3 Agent Status Reports Enables you to track and update status reports for different

agents and agent groups.
4 Contact Detail Reports Enables you to track and update customer records.
5 Error list Displays system errors.

Interface tabs
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Administration tab

Number Button Description
1 Configuration Enables you to perform general configuration,

including creating agents and agent groups. For more
information about using this module, see Using the
Avaya IP Office Contact Center Configuration and
User Interface Configuration Modules.

2 UI configuration Enables you to configure UI options. For more
information, see the “UI Configuration” chapter in
Using the Avaya IP Office Contact Center
Configuration and User Interface Configuration
Modules.

3 Task Flow Editor Allows you to view, create, and edit Task Flow Editor
scripts.

For general information about working with Task Flow
Editor scripts, see Administering Avaya IP Office
Contact Center Task Flow Editor .

Table continues…
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Number Button Description
For information about configuring the Task Flow
Editor, see Avaya IP Office Contact Center Task Flow
Editor Telephony Task Based Guide.

4 IVR Editor Allows you to view, create, and edit IVR Editor
scripts.

For general information about working with IVR Editor
scripts, see Administering Avaya IP Office Contact
Center IVR Editor .

For information about configuring the IVR Editor and
for IVR scenarios, see Avaya IP Office Contact
Center IVR Editor Scenarios Task Based Guide.

5 Dialer Enables you to configure dialer calls, such as
automatic outbound calls. For more information about
using this module, see Administering Avaya IP Office
Contact Center Dialer .

6 Email Configuration Enables you to configure email functionality. For
more information, see Avaya IP Office Contact
Center Email and Chat Services Task Based Guide.

7 Text Block Administration Enables you to set up text blocks that agents can use
when sending emails. For more information about
using this module, see Administering Avaya IP Office
Contact Center Text Blocks.

8 Address Book Administration Enables you to create address book entries that
agents can use. For more information about using
this module, see Administering Avaya IP Office
Contact Center Address Books .

Menu bar
You can select a component from the menu bar or press the F10 or Alt key and use the cursor to
navigate.

Name Description
File From this menu, you can access the following options:

• Change password

• Change alias

• Change audio/visual notification

• Exit
Table continues…
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Name Description
Go to You can open any Agent, Supervision, or Administration module from this menu. You

can also open a module from the Agent, Supervision, or Administration tabs.
Help From this menu, you can access the following options:

• Contents: To view online help content.

• Information: To view information about the IP Office Contact Center User
Interface for Windows version you are using.

• Reporting counters: To view the ReportingCounters pdf in the language used by
the logged in agents. This option is only available to agents with privileges to
access the reporting application.

Information messages
When you minimize the view, the following information message indicators are displayed:

Indicator Description
Specifies that you have no messages.

Specifies that you have messages. If you have unread messages, the indicator
flashes. Unread messages are displayed in bold.

When you click a message, it is marked as “Read”.

Connection messages
The system displays a message when the connection to the telephone PBX or email system is
interrupted. You can view the messages on the Error list screen.

Realtime Information messages
If an element in the Realtime Information module exceeds the configured alarm threshold, a
message is displayed. The message disappears when the alarm status changes. You can view
these types of messages in the Realtime Information module.

Telephony messages
When you are logged out of the Telephony module, the system displays a message that indicates
the reason. Depending on the reason, you might be prompted to log in again.
If the task server restarts, you get logged out and you must log in again. You cannot log in, for
example, if you are logged out remotely or if you are logged in to another computer. In these
cases, the system does not provide the option to log in again.
The following are examples of the types of messages that might be displayed:

• Connection to PBX is broken. Click here to log in again.
• Connection to the PBX is established again. Click here to log in
again.

• You have been logged out from the telephone, another user has logged
in.

Navigation
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• Telephony function "Call routing" is active. Click on here to
deactivate it and log in again.

• Telephone function "do not disturb" is active. Click on the button
to deactivate it and login again.

Menu bar status information and messages
The menu bar also displays the following information:

• The time that the agent logs in.

• The time that the agent is on a break.

• The status of the logged in agent for Telephony, Email, and Chat.

• The name of the logged in agent and the configured telephone extension.

• Information message indicator.

Shortcut keys

Telephony contact bar key sequence
Key sequence Description
Ctrl + Shift + A Answer

Ctrl + Shift + D Dial

Ctrl + Shift + S Hang up

Ctrl + Shift + H Hold

Ctrl + Shift + O Consult

Ctrl + Shift + T Transfer

Ctrl + Shift + K Conference

Ctrl + W Wrap up

Ctrl + Shift + U Extend Wrap up

Ctrl + Shift + W End Wrap up

Ctrl + Shift + J Job code

Ctrl + Shift + C Coach

Ctrl + Shift + E Emergency

Table continues…
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Key sequence Description
Ctrl + Shift + N DTMF

Ctrl + Shift + M Silent monitoring

Ctrl + T Toggle

Ctrl + Shift + G Assistance

Ctrl + Shift + L Right Party Contact (RPC)

Ctrl + Shift + B Closure

Ctrl + Shift + F Fax

Ctrl + R Recording

Ctrl + Shift + R Pause recording

Formatting and editing key sequences
Key sequence Description
Ctrl + A Select all

Ctrl + C Copy to clipboard

Ctrl + V Paste

Ctrl + X Cut

Ctrl + Z Undo

Ctrl + Y Retry

Ctrl + B Bold font

Ctrl + I Italic font

Ctrl + U Underline

Ctrl + E Center

Ctrl + L Align left

Ctrl + R Align right

Ctrl + Shift + Z Delete formatting

Ctrl + + Bigger type size

Ctrl + - Smaller type size

Ctrl + Shift + + Increase indent

Ctrl + Shift + - Decrease indent

Navigation
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Page navigation key sequences
Key sequence Description
Ctrl + Home First page

Ctrl + End Last page

Ctrl + Page Down Previous page

Ctrl + Page Up Next page

Email function key sequences
Key sequence Description
Ctrl + N Create new email

Ctrl + R Reply

Ctrl + Shift + R Additional reply options

Ctrl + Shift + I Reply all with or without the original message

Ctrl + W Forward

Ctrl + G Delegate

Ctrl + Shift + K Defer

Ctrl + D Delete

Ctrl + Shift + A Use job code

Ctrl + Shift + E Send

Ctrl + H Add attachment

Ctrl + S Save

Ctrl + T Activate the selected email

Ctrl + F Activate the search filter

Ctrl + O Set the focus on the current folder list

Ctrl + Shift + T Select text blocks
ESCAPE Leave text block, and continue editing the email

Chat key sequence
Name Description
Tab Switches among list view, chat progress, and chat input.

Table continues…
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Name Description
Chat progress displays details about a chat.

Chat input is the area where you enter text in a chat.
Ctrl + Tab Switches between the Requests and Archive tab.

Ctrl + T Activates the selected chat request.

Ctrl + O Displays the list view.

Ctrl + F Sets the focus in the chat archive to the search filter.

Ctrl + Shift + A Use job code.

Ctrl + Shift + E End the chat request.

Navigation
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Chapter 4: Administration options

This chapter provides a brief overview of the options available to administrators. This document
does not provide detailed information about administration tasks for which separate documents are
available.

Configuration module
The Configuration ( ) module is the central module for configuring objects, which agents can
use with the telephony, email, or chat task types. You can also use the Configuration module to
configure the system settings, change configurations, and delete objects in IP Office Contact
Center.

For more information about this module, see Using the Avaya IP Office Contact Center
Configuration and User Interface Configuration Modules.

UI Configuration module
The UI Configuration ( ) module is used to configure the contact bar for a profile or an agent.
You can also assign the configured Home and Telephony real time view to a profile or an agent.
For more information about this module, see Using the Avaya IP Office Contact Center
Configuration and User Interface Configuration Modules.

Task Flow Editor module
The Task Flow Editor ( ) module controls routing configuration for voice, email, and chat tasks
within IP Office Contact Center. A task flow set is a graphical representation of the message
distribution within IP Office Contact Center. The messages can be phone calls, voice mails, or
emails. The message distribution determines how IP Office Contact Center handles messages
and the processes that the system starts.
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A task flow set has two groups:

• Macro

• Task flows

You require a macro to use the same process in more than one task flow without creating the
sequence of processes again.

For more information about working with this module, see the following documents:

• Administering Avaya IP Office Contact Center Task Flow Editor : To understand the Task
Flow Editor options available with the IP Office Contact Center User Interface for Windows.

• Avaya IP Office Contact Center Task Flow Editor Telephony Task Based Guide: To configure
Task Flow Editor.

IVR Editor module
The Interactive Voice Response (IVR) ( ) module provides customer services, such as automatic
announcements and Text To Speech (TTS). The IVR Editor includes the following:

• DTMF tone recognition for evaluating subscriber entries.

• Announcement creation with .WAV files, TTS, or automatic speech recognition. You can write
TTS text in a script element, a text file, or a CallTag. Support for automatic speech
recognition is also available with MRCP integration.

• Voice mail recording and distribution. You can also forward voice mails to an agent through
email.

• Read and write access to content stored in external databases.

• Script features, such as creating scripts, and adding or editing elements.

• Telephony functions with querying elements, such as call, refer back, and transfer.

Note:
• Speech recognition is not supported in IP Office.

• The IVR Editor module is optional and can be used to create and edit IVR scripts for IP
Office Contact Center. You can use the Configuration module to configure the IVR Voice
Control environment.

IVR scripts contain the following information:

For more information about working with this module, see the following documents:

• Administering Avaya IP Office Contact Center IVR Editor : To understand the IVR Editor
options available with the IP Office Contact Center User Interface for Windows.

• Avaya IP Office Contact Center IVR Editor Scenarios Task Based Guide: To configure IVR
Editor.
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Dialer module
The Dialer ( ) module includes the outbound dialer function, which starts automatic outbound
calls. In an outbound call, an agent need not call a subscriber of the public network. For example,
If you conduct a phone survey within a company, then the survey can be an outbound function.

Depending on the Dialer mode you are using, the IP Office Contact Center outbound dialer
supports one of the following:

• Starts the call from IP Office Contact Center, and then distributes the call to an available
agent.

• Presents the call to an agent for preview, and then the agent starts the call.

In IP Office Contact Center, the basis of the call distribution process is jobs. The system starts a
job for a topic.

In addition to increasing the productivity of agents, outbound dialer functionality can be used for
one of the following:

• Informational campaigns

• Advertising campaigns

• Callback requests

For more information about working with this module, see the following documents:

• Administering Avaya IP Office Contact Center Dialer : To understand the Dialer options
available with the IP Office Contact Center User Interface for Windows.

• Avaya IP Office Contact Center Dialer Task Based Guide: To configure Dialer.

Email Configuration module
The Email Configuration ( ) module enables administrators to configure email and IM
functionality. You require multichannel agent licenses for the agents and agent groups that will be
using the email and IM features.

For more information about working with this module, see Avaya IP Office Contact Center Email
and Chat Services Task Based Guide.

Dialer module
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Text Block Administration module
You can use the Text Block Administration ( ) module to create and update the text blocks that
agents use in the Email module. You can also create an automatic reply template and assign it to
topics. You can use this module to:

• Create, change, and delete text blocks.

• Create text blocks in international languages.

• Rename text blocks.

• Arrange the text blocks in a category.

• Format text blocks.

• Assign text blocks to topics.

• Create, change, and delete automatic reply templates.

• Assign an automatic reply template to a topic.

• Use placeholders in text blocks and automatic reply templates.

For more information about working with this module, see Administering Avaya IP Office Contact
Center Text Blocks.

Address Book Administration module
The Address Book Administration ( ) module enables you to configure an address book with
customer details. The Email module can also be integrated with the address book functionality.

You can use the Address Book Administration module to:

• Add, change, and delete address books.

• Add, change, and delete address book profiles.

• Edit the settings of the address book server.

• View the import log.

You cannot use the drag-and-drop function in the Address Book Administration module.

For more information about working with this module, see Administering Avaya IP Office Contact
Center Address Books .
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Part 1: Agent operations
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Chapter 5: General agent operations

This chapter describes general operations that all agents can perform, regardless of which channels
(telephony, email, or chat) they are signed in to.

Agent status indicators
Indicator Description

No connection to the task server.

Not logged in.

Logged in and signed in to at least one agent group, but not all agent groups.

Logged in, but not signed in to any agent group.

Logged in and signed in to all agent groups.

Logged in with a pending break request.

Logged in, but on a break.

Agent groups and profiles
Agents must be signed in to agent groups to access telephony, email, and chat functionality. The
functionality configured for each agent group can vary. For example, if an agent group is only
configured for telephony, you cannot access email and chat using that agent group. You can also
use profiles to sign in to a specific subset of agent groups.

Creating and deleting profiles
About this task
You can create a profile with a specific subset of agent groups to keep from always having to
manually select the same agent groups. When you sign in to agent groups, you can simply select
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the appropriate profile and you will be signed in to all the agent groups in the profile. You can
create as many profiles as you need.

Procedure
1. From the top right corner of the UI, click , and then click Select AG.

The Agent group selection dialog box is displayed.

2. To save a selection of agent groups as a profile, do the following:

a. Select the appropriate agent groups.

b. Click .

c. In the Save configuration dialog box, type a name for the profile, and then click OK.

3. To delete a profile, do the following:

a. Select a profile.

b. Click .

c. Click OK.

Signing in to and out of agent groups manually
About this task
Use this procedure to manually sign in to and out of agent groups. You do not need to use this
procedure to sign in to agent groups if your administrator has configured the Automatic sign in
option.

Procedure
1. From the top right corner of the UI, click , and then click Select AG.

The Agent group selection dialog box is displayed.

2. To manually sign in to agent groups, do one of the following and then click OK:

• If you have created profiles, select the appropriate profile to sign in to all the agent
groups in the profile.

• Select one or more agent groups from the Telephony ( ), Email ( ), or Chat ( )
channel area.

• To sign in to all agent groups, from the channel area, click Sign on to all AGs.

Agent groups appear under the channels they are configured with. An agent group that is
configured for telephony, email, and chat is displayed under all channel areas. To use the
agent group with all channels, select it from all channel areas.

3. To sign out of agent groups:

• Clear the check boxes for the agent groups that you want to sign out of.

Agent groups and profiles
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• To sign out of all agent groups, from the channel area, click Sign off from all AGs.

Starting and ending a break
About this task
Use the break option to temporarily stop working in IP Office Contact Center.

Before you begin
Your administrator must define break types or codes in the Configuration module.

Procedure
1. On the status bar, click  next to the channel from which you want to take a break, and

then click Break Time.

The Break Time dialog box is displayed.

2. To start a break, do the following:

a. Click Break Time.

b. If prompted, select a break type.

3. To end your break and continue working in the IP Office Contact Center system, click Off
Break Time.

Break policies and restrictions
Your administrator can configure a sign off prevention quota in the IP Office Contact Center User
Interface for Windows or the IP Office Contact Center web administration portal. This quota
defines the minimum number of agents that must remain signed in to agent groups. The
administrator can also specify whether agents can take a break during sign off prevention. Unless
break time is allowed by your administrator, you will not be able to take a break during sign off
prevention.

The following are examples of circumstances that might prevent you from taking a break:

• Call volume is high.

• Multiple agents are already on break. A certain number of agents must always be available.

• Another break was taken recently.

If your break cannot be granted immediately, the grey  indicator is displayed to inform you that
your break is pending.

General agent operations
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When your break is granted, the red  indicator displays next to each channel. A break is
granted for all channels simultaneously. While you are on break:

• You cannot receive contact center calls, emails, or IM chats. You start receiving new calls,
emails, and chats again after you return from break.

• You cannot activate contact center emails. The Activate button becomes available again
when you return from break.

Starting and ending a break
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Chapter 6: Telephony

This chapter describes the telephony functionality available to agents in the IP Office Contact Center
User Interface for Windows. General information, which is also available to agents who are not
using the Telephony module, is not described in this chapter.
When you sign in to your agent groups, you must select the agent groups from the Telephony
channel area. Otherwise, you cannot access telephony functionality.

Telephony contact bar
When you are on a call, the Telephony contact bar contains a contact information area and a
function bar. The contact information area displays call details. The function bar contains icons that
you can click to execute telephony commands.

Contact information area
The contact information area displays the following call information with one line for each call:

• Message text.
• Call direction, inbound or outbound.
• Call status. For example, dialing, busy, or on hold.
• Topic name.
• Conversation length.
• The remaining wrap up time.

If time is activated manually, nothing is displayed because the time is not limited. In this case,
wrap-up time must also be closed again manually.

Note:
The IP Office wrap up time must be less than the configured IP Office Contact Center wrap
up time. Typically, the wrap up time configured in IP Office is less than 10 seconds.

• The name of the customer, if known, or the telephone number.

Note:
The system continues to display the customer name even after the customer drops the
call.
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Managing calls

Answering a call or picking up a call from the queue
About this task
If your administrator has configured a time period for answering calls, then you must answer an
incoming call before this time elapses. Otherwise, you are automatically signed out of all agent
groups.
You can also pick up a call in the queue from the Telephony screen if you have the “Redirect from
Queue” privilege.

Procedure
• To answer a call, click Answer ( ).

• To pick up a call in the queue, right-click the call row and click Pick up.

Telephone book search options
Using the telephone book, you can search and select phone numbers for making calls. You can
search for the following criteria:

• Last name
• First name
• Title
• Phone number
• City
• Company

The search is not case sensitive. When you perform a search, a list of matching data up to 250
records appears. If more than 250 records are available, you must narrow down your search.
You can click Details to obtain more information about an entry. All available information is
displayed.

Search examples
The following table provides guidelines for search terms:

Placeholder Description Example Result
% Placeholder for any

character.
%en Searches for all entries containing ‘en’.

Table continues…
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Placeholder Description Example Result
_ Placeholder for any

character.
_ish Searches for all entries starting with any

character followed by ‘ish’.
[character] Placeholder for a certain

character.
M[ae][iy]er Searches for all entries with Maier, Mayer, Meier,

or Meyer.
[character -

character]

Placeholder for a certain
string.

[M-Z]owell Searches for all entries starting with a letter from
M to Z followed by ‘owell’.

* Placeholder for any
character.

* Searches for all entries.

Making a call
Procedure

1. Click Dial ( ).

2. In the Dial dialog box, do one of the following:

• Type a number in the Number selection box.

• Select a number from the selection box.

• If configured, select a number from the telephone book as described in Telephone book
search options on page 35.

Administrators are responsible for configuring address books and telephone books.

3. (Optional) To mark the call as a call center-specific call, do the following:

a. Select Outgoing ACD call.
b. Select internal for an internal call or external for an external call.

c. Select a topic.

Note:

For outgoing ACD calls, you cannot dial a topic number.

When reports are generated, the call for the selected topic is listed as a call center call,
and the counter names in the report contain “outcc”.

4. Click Dial.

Making consultation calls
About this task
While you are on an active call, you can start a new consultation call. You can use a consultation
call to obtain information that you need to complete your first call.

Telephony
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Before you begin
An active call must be in progress.

Procedure
1. During an active call, on the contact bar, click Consultation ( ).

This call is put on hold.

2. In the Consultation window, do one of the following:

• Type or select a number in the Number selection box.

• If configured, select a number from the telephone book as described in Telephone book
search options on page 35.

Administrators are responsible for configuring address books and telephone books.

3. Click Dial.
4. (Optional) To toggle between both calls, click Toggle ( ).

5. When you are ready to end the consultation call, click Hang up ( ).

6. Click Hold ( ) to retrieve your first call.

Starting a conference call
About this task
Use this procedure to merge two calls into a conference call.

Before you begin
An active call must be in progress.

Procedure
1. Start a consultation call.

Follow step 1 on page 37 to step 3 on page 37.

2. On the contact bar, click Conference ( ).

A three-party conference call starts between you and the other two parties.

3. (Optional) To withdraw from the conference, click Hang up ( ).

The other two parties remain connected.
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Entering digits during a call
About this task
You might need to enter dual-tone multi-frequency (DTMF) digits during certain calls. For example,
in your voice mailbox, you use DTMF digits to enter your login password and select options.

Procedure
1. On the contact bar, click DTMF ( ).

2. Select the required digits.

3. Close the DTMF window.

Putting a call on hold
Procedure

1. In the call area for your active call, click Hold ( ).

2. To resume the call, click Hold again.

Redialing the last number
About this task
You can redial a number anytime.

Procedure
1. On the contact bar, click Dial ( ).

2. Click the arrow to view the last 10 numbers dialed.

3. Click Dial to call the last number dialed.

Transferring a call
About this task
Use this procedure to transfer a call to another extension if that extension is free. You cannot
transfer a call to a busy extension.

Procedure
1. Start a consultation call.

Follow step 1 on page 37 to step 3 on page 37.
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2. If the extension is free, click Transfer ( ).

Both parties are connected.

Requesting support during a call
Procedure

To request active supervisor support, click Emergency ( ).

The supervisor can join the call and actively participate in it.

Ending a call
Procedure

Click Hang up ( ).

Result
At the end of a call, wrap up or Active Call Work (ACW) time begins. Use this time to select or
enter job codes, and complete any other post-call processing. After wrap up time is complete, a
new call can be assigned to you.

Working with wrap up or ACW time
About this task
ACW is configured by your administrator and can last between 0 to 100 seconds.
Use this procedure to manually start, extend, or turn off wrap up time. You can also request
manual wrap up time during a call. The manual wrap up time will start after the call ends.

Note:
If you start an outgoing ACD call during the wrap up for a previous call, the wrap up for the
previous call will be stopped.

Procedure
• To start manual wrap up time or extend the preconfigured wrap up time, click Wrap up ( ).

The Wrap up button turns dark green.

• If you complete your task early, click Wrap up again to manually turn off wrap up time.

The button turns grey and wrap up time is complete.
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Entering a job code
About this task
Job codes define the outcome or result of a call. If job codes are mandatory, you must enter or
select job codes before you can start a new call. You can select or enter multiple job codes for a
call. The length of job codes is predefined.

Note:
All job codes entered for a call are saved in historical reporting. However, only the first one is
displayed in Contact Detail records.

Procedure
1. Click Job Codes ( ).

2. Do one of the following:

• Select a Job Code.

• In Unrestricted entry, enter a job code.

3. Click  to add the job code to the list.

You can repeat this step to add additional job codes.

4. (Optional) To remove a job code from the list, click .

5. To confirm and submit your job codes, click Send.

Outbound dialer calls
IP Office Contact Center uses the outbound dialer functionality to automatically assign outgoing
calls to agents. An outbound caller ID is generated for each call. Outbound dialer calls can be set
up in the following ways:

• IP Office Contact Center makes the outgoing call automatically. After the connection with the
called party is established, IP Office Contact Center immediately distributes the call to an
agent to handle.

• IP Office Contact Center distributes details about the call to an agent in Preview mode. The
agent can choose to start the call immediately or wait for the pre-announcement to expire.

• IP Office Contact Center makes the outgoing call
For more information about outbound dialer, see:

• Avaya IP Office Contact Center Feature Description
• Administering Avaya IP Office Contact Center Dialer
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Call qualification options
Qualifying a call as correct

About this task
Use this procedure when the call is successful and you reach the correct party.

Procedure
1. On the contact bar, click Right Party Contact qualification (RPC) ( ).

2. In the RPC window, select qualifications on the left pane and add them to the list.

You can only select qualification options that your administrator has configured. The
selected values are saved as additional information tags on the call job tag.

Qualifying a call as incorrect
About this task
Use this procedure when the call is unsuccessful or you have not reached the correct party.

Procedure
1. On the contact bar, click Closure qualification ( ).

2. In the Closure dialog box, use the available options to qualify a call.

The available options are described in Closure qualification field descriptions on page 41.

3. To complete the qualification, click OK.

Closure qualification field descriptions
When you qualify a call as incorrect, the following options are available:

Name Description
Follow up Specifies that the call will be repeated at a later time.
Wrong number Specifies that you dialed the wrong number.
New number Enables you to enter a a new number.
AM Specifies that you reached an answering machine (AM).

• If you indicate a time, the system generates a new job.

• If you do not indicate a time, the system closes the job.
Check box Enables you to limit the time during which a new call is made.
Start time Specifies the start time of a new call.
Stop time Specifies the stop time of a new call.
Today Indicates that a new call will be made today in approximately 1 hour.
Tomorrow Indicates that a new call will be made tomorrow. The call must occur in 24 hours.
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Qualifying a call as a fax machine
About this task
Use this procedure when the call reaches a fax machine.

Procedure

On the contact bar, click Qualification as fax abandoned ( ).

Customer information and web access
You can access the customer history and configured websites only if your administrator has
configured telephony files that contain customer history and web access. This configuration is
done using the UI Configuration module.

In the IP Office Contact Center User Interface for Windows, you can do the following:

• View customer details in the Customer History view while you are on an active call or during
wrap up time for a call. You can also view customer details at the bottom of an email or chat
conversation.

• Use the Note section, add or sort notes and view notes from other agents.

• Perform research for customers on the internet using configured websites. The default
website configured opens automatically in a browser window or tab in the UI. Depending on
your configuration, you might also be able to access other websites.

Note:

The IP Office Contact Center User Interface for Windows supports only Internet Explorer.
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Chapter 7: Email

This chapter describes the email functionality available to agents in the IP Office Contact Center
User Interface for Windows. When you sign in to your agent groups, you must select the agent
group from the Email channel area. Otherwise, you cannot access email functionality.

You can perform the following tasks from the Email screen:

• View unread emails. When you receive a new email, a visual notification displays in the UI.

• Create and send emails.

• Reply to the sender of an email or to all users on the email distribution list.

• Forward an email to one or more people.

• Delete emails. You can only delete topic emails if your administrator has given you the
appropriate privilege.

• Save email drafts. For example, if you start typing an email but cannot finish right away, then
you can save the draft and finish typing the email later.

• Add attachments, such as files and images, to an email before sending it.

• Reassign or delegate customer emails to another agent or supervisor.

• Update the status of emails. After you finish addressing a customer action, you can set the
email status to Complete. If you cannot address a customer issue right away, you can set the
email status to Defer and then follow up on the email later.

• Select job codes that define the outcome of the email exchange.

• Print emails.

• View archived emails if your administrator has given you the appropriate privilege.

Email navigation
The following image shows an example of the IP Office Contact Center User Interface for
Windows with the Email screen open:
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No. Name Description
1 Menu bar Displays menus, such as File, Go to, Email Client, and Help.

Some of the available menus vary depending on the module selected.
For example, Email Client is only visible when the Email module is
selected.

2 Toolbar and status
bar

Displays the toolbar and status bar.

3 Mailbox folders Displays the mailbox folders.
4 Email list Displays the list of emails in the folder.
5 Action bar Displays the actions that you can perform.
6 Processing status

indicator
Displays the status of emails.

7 Display and
processing area

Provides formatting options for an email.

8 Text blocks Enables you to insert a text block into an email.
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Email transmission status indicators
Icon Description

Specifies a successful transmission.

Specifies that the transmission failed.

Specifies that the transmission is active and is being processed.

Specifies that the transmission is being reattempted.

Specifies that the transmission stopped.

Mailbox folder descriptions
Folder name Description
Overview Contains emails that have not yet been assigned. You can pick up or

delegate an email from this folder.
Inbox Contains incoming emails that are assigned to a user.
Sent Contains sent emails.
Drafts Contains saved emails that are still in progress and have not yet been sent.
Recycle bin Stores all the emails that are deleted.

You can move deleted emails from this folder to other folders. Emails in this
folder can be permanently deleted or delegated back to a topic. Emails in
this folder cannot be delegated to an agent.

Deferred Stores on-hold emails until the follow-up time configured. At this time, the
emails reappear in the Inbox.

Completed Stores all completed or closed emails that are not removed from the email
database.

Transactions, including the original emails and the associated replies or
forwarded emails, are linked to each other with a transaction number or ID.

Outbox Stores emails that are answered, but not completed or closed.
Archive Contains completed emails that have already been moved from the Runtime

database to an external database during a store run. The Archive folder is
only available if a transfer of completed emails to an external store database
is planned and the UMRClientAdapter is configured accordingly.
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Paging through mailbox folders
About this task
If you set the Maximum rows displayed option, a line is displayed below each entry. If you have
selected the Always display paging info option, the scroll functions are always available.

Procedure
• To page through the search results, click one of the following:

- : To go to the next page.

- : To go to the previous page.

- : To go the last page.

- : To go the first page.

• To go to a particular page, enter the page number and click Go to.

Searching for emails
About this task
Use this procedure to search for an email in any mailbox folder. You can also restrict the number
of emails that are displayed in each folder.

Procedure
1. To view search options in an email folder, do the following:

a. Click Additional options > Show search filter.

If a folder has more than 100 emails, the search option is displayed automatically. By
default, the number of lines displayed is set to 100.

b. Choose the appropriate search criteria using the information in Search criteria
descriptions on page 47.

c. Click Use filter ( ).

The relevant emails are displayed.

2. (Optional) To clear all fields, click Reset filter ( ).

3. (Optional) To hide the input fields for the search function, click Close ( ).
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Search criteria descriptions
Search option Description
Search for Searches for parts of words.
Search in Enables you to search in the Subject or the body text.
Recipient Searches for a recipient.
From Searches for a sender.
From To Enables you to select a date for which you want to search in the From or To

fields. You can also enter a time in the relevant field. The From field defaults
automatically to 00:00 and the To field defaults automatically to 23:59.

Topics Searches for a topic.
Ticket ID Searches for a Ticket ID in the Completed folder.
Mailbox Searches for mailboxes in the Completed and Overview folders.
Status Displays the status of the email. For example, Forwarded, Received, Replied,

and Sent.

Searching in the Archive folder
About this task
If you have the View Extended Archive privilege, you can search for mailboxes of deleted agents
or topics from the Archive folder. You cannot disable or hide the search options in the Archive
folder.

Procedure
To search the mailboxes of deleted agents and topics, do the following:

a. Perform a search in the Archive folder.

In the mailbox list, the mailboxes of deleted agents and topics are displayed in a different
font.

b. (Optional) Select an agent or topic.

Activating emails
About this task
You must activate an email before you can reply to it, forward it, or perform any other tasks with it.
You can activate only one email at a time. If you activate a second email, the first email you
activated is put in the Interrupted state. When you close an active email, it is also put in the
Interrupted state.
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Note:
You cannot activate emails while you are on break.

Procedure
Do one of the following to activate an email:

• Double-click the email.

• Right-click the email, and then click Activate.

Picking up emails
Procedure

1. In the Overview folder, select an email.

2. Click Pick ( ).

The email is placed in your inbox for processing.

Creating signatures
About this task
You can create a personal signature to include in the emails you send. A signature can either be
included in new emails only or in all emails.

Procedure
1. Click Additional options > Signature.

2. In the Personal signature dialog box, type your signature.

3. Select Use signature.

4. Click OK.

Creating, replying to, and forwarding emails
About this task
Use this procedure to create new emails, reply to emails assigned to you, and forward emails. You
can also attach files to emails.
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You can set your name or a topic as the sender of an email. For replies, the topic through which
the email was sent is usually used as the sender. For forwarded or new emails, the agent is set as
the default sender.

Before you begin
You must activate an email before you can reply to or forward it.

Procedure
1. In the Inbox folder, do one of the following:

• To create a new email, click New ( ).

• To reply only to the sender of an email, click Reply ( ).

You can select a sender email address from the From field.

• To reply to everyone on the email distribution list, click Reply all ( ).

• To forward an email, click Forward ( ).

2. In the To, Cc, or Bcc fields, do one of the following:

• Type the email address of the recipient.

• Click the field, search for the recipient in the address book, and then click OK.

3. Repeat the previous step to add more recipients.

If you want to add multiple recipients, separate each email address with a semi-colon.

4. Type a subject if you are creating a new message.

5. Type text into the body of the email.

6. To attach a file, click Add attachment ( ).

7. To send the email, click Send ( ).

Setting send options
About this task
You can configure send options for all outgoing emails, including new emails, replies, and
forwarded emails. You can also update send options in a saved email.

Procedure
1. Click Send options ( ).

2. Set one or more of the options described in Send options on page 50.

3. Click OK.

4. (Optional) To discard the settings, click Cancel.
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Send options
Options Description
Account Displays the account number.
Send priority Enables you to change the priority of the email. The options are:

• Normal: The default setting.

• Low ( ).

• High ( ).
Acknowledgm.of.receipt Enables you to request a receipt of acknowledgement, which you

will get when the recipient opens the email.
Immediately Enables you to have the email sent immediately.
Time Specifies the time when the email is sent.

By default, the current date and time are displayed. You can also
select a different date and time.

Displaying and changing transmission settings
About this task
You can view and change the transmission settings. You cannot change the properties of an
address book entry in the address book. If you change a transmission setting, these changes only
apply to the current transmission job.

Procedure
1. In the message or in the addressing window, double-click the entry in the To, Cc, or Bcc

field.

2. In the Send details dialog box, change the following transmission settings:

• Service
• Target
• First name
• Name
• Street
• ZIP code
• Town
• Country
• Company

3. Click OK.
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Deleting emails
Procedure

1. Select an email.

2. Click Delete ( ).

Saving an email draft
About this task
If you cannot finish an email right away, you can save a draft and then finish the email later. You
can access saved emails from the Drafts folder.

Procedure
1. Start typing an email.

2. To save a draft of the email, click Save ( ).

Resending emails
About this task
Use this procedure to resend an email in the Sent folder.

Procedure
1. In the Sent folder, right-click the email and select Show send state.

2. Select the email and click Resend ( ).

3. Edit the email and enter a new subject or address if necessary.

4. To send the email, click Send ( ).

Resending a failed email
About this task
You can resend an email that did not go through from the Sent folder.

Procedure
1. In the Sent folder, right-click the email that could not be transmitted.

2. In the pop-up menu, click Show send state.
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3. Select the failed email.

4. Click Retry ( ).

Performing spell checks
About this task
After you compose a message, you can check the Subject and the body for spelling mistakes. If
your administrator has enabled automatic spell checks, you must perform a spell check before you
can send an email. Otherwise, spell checks are optional.
When you perform a spell check, the system displays entries that are not found in the dictionary
and suggests a replacement. You can accept or ignore the suggestions.

Before you begin
Ensure that Microsoft Office 2007 or later is installed on your computer.

Procedure
1. Within a message, click Spelling ( ).

The first unrecognized entry is displayed along with a suggested change. When you finish
with the first entry, the next unrecognized entry is displayed.

2. Do one of the following:

• To apply the change, click Change.

The entry is automatically updated and the next unrecognized entry is displayed.
• To select a replacement word, from the Suggestions list, select a word.
• To ignore the suggested change, click Ignore.
• To undo the change for all instances of a word, click Ignore all.

3. Click Apply.

The system applies the selected changes to the text and displays the modified text.

4. (Optional) If you do not want to apply the changes, click Close and then click OK.

Opening and saving attachments in an email
About this task
Use this procedure to open or save an attachment from an email you received. Each attachment
displays the file name and size in bytes.
You can open the attachment directly if the type of attachment is known or if an appropriate
application is registered. If the type is unknown, you must first download the attachment. If the file
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does not open in the program that you expect, contact your system administrator to help you
change your settings.

Before you begin
You must activate an email before you can access the attachments in it.

Procedure
• Right-click the attachment, and then click one the following:

- Open
- Save

• (Optional) To remove the attachment, Click Remove.

Inserting text blocks
About this task
You can add preconfigured blocks of text into an email to keep from repeatedly typing the same
message.
Text blocks can contain a placeholder, which is a type of variable. A placeholder can be used to
insert extra information into the message. A placeholder is typically substituted by an
administrator.

Note:
When a change is made to a text block, you must sign out and sign in again to see and use
the changed text block.

Before you begin
Your administrator must create text blocks for you to use and assign the Use Text Block privilege
to you.

Procedure
1. Navigate to the desired text block option.

2. (Optional) If required, sort text blocks by:

• Language: To only view text blocks in a specific language.

• Topic: To only view text blocks in a specific topic.

3. To add your selected text block to a message, do one of the following:

• Double-click the text block.

• Click Paste.

4. (Optional) If you are sending a message with placeholders, enter the appropriate
information for each placeholder in the Replace unknown placeholders dialog box.
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5. Click OK.

Showing and hiding the text block view
Procedure

1. To hide text templates, click .

2. To show text templates, click .

Printing emails
Before you begin
Connect your computer to a printer with the appropriate privileges.

Procedure
1. Click Print ( ).

2. In the Print dialog box, select the printer.

3. Click Apply.

4. Click OK.

Emptying the recycle bin
Procedure
Click Additional options > Empty recycle bin.

Result
All emails in the Recycle bin folder are deleted. You cannot undo this delete action.

Reassigning an email
About this task
Use this procedure to reassign or delegate an email to another agent or topic.

Procedure
1. Click Delegate ( ).
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2. From the destination list box, select a destination.

Destinations are divided into topics and agents. You can delegate an email to an agent that
is temporarily unavailable.

3. (Optional) Type a note with information about the email you are delegating.

4. Click Delegate.

Result
The email is no longer displayed in your mailbox.

Deferring an email
About this task
If you cannot immediately address a customer email, you can put the email item on hold and then
address it later. When you defer an email, you can set a follow-up date and add notes for yourself.

Procedure
1. Select the appropriate email.

2. Click Defer ( ).

3. Enter a follow-up date and time.

4. (Optional) Type a note for yourself.

5. Click Defer to complete the process.

Result
The email is stored in the Deferred folder until the date and time you specified. At the specified
time, the email reappears in your Inbox.

Setting an email to “Complete”
About this task
When configuring job codes in the IP Office Contact Center User Interface for Windows, your
administrator can choose whether to make job code selection mandatory or optional. If job code
selection is mandatory, you must select a job code before you can set an email to Complete. If job
code selection is optional, you can set an email to Complete right away without selecting a job
code.

Procedure
1. Select the appropriate email.
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2. (Optional) If job code selection is mandatory, click Job code ( ).

3. Click Complete ( ).

Result
Completed emails are stored in the Completed folder. These emails do not appear in your Inbox.

Viewing message properties
About this task
Every message in the system has certain properties. When a new message is sent to a topic, a
Ticket ID is assigned to the message. Ticket IDs are used to connect customer requests that are
related to the same transaction. You can track the events associated with a message using Ticket
IDs.

Before you begin
Your administrator must set the Add ticket ID in subject option in the Configuration module.

Procedure
1. Right-click a message.

2. In the pop-up menu, click Properties.

The system displays the following message properties:

• Document ID

• Folders

• Write-protection

• Mailbox

• Send priority

• Replied

• Forwarded

• Automatic reply

• Task status

• Original topic

• Current topic

• Attributes
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Address books overview
In the Email module, you can use a personal address book, a shared address book, or both. In the
address book, you can select names, email addresses, and distribution lists.

In an email message, when you type the first letter of the name of a recipient in the To, Cc, or Bcc
fields, the address book searches for matching names. If a matching name is found, it is inserted
in the email address field. If a matching name is not found, the system displays a message asking
for more information.

In addition to using an address book to address messages, you can search for other information in
the address book, such as office addresses and telephone numbers, by typing a name.

Note:

Agents can use one or more configured address books. Address books are configured by
administrators.

Searching address books
Procedure

1. In an active email, click To.

2. Select the appropriate address book type and enter your search criteria.

3. Click Search.

4. From the list of entries, select the appropriate entry.

5. Click OK.

You can add or delete addresses, if required.

Customizing mailbox folders

Customizing email options
About this task
This is an optional customization procedure.

Procedure
1. Click Additional options > Options.

2. In the Options dialog box, update the settings using the information in Options dialog box
descriptions on page 58.
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3. Click OK.

Options dialog box descriptions
Option Description
Activate call center email on
selection

Activates a message automatically when you click it.

Show CC input Displays the CC field when you are processing a message.
Show BCC input Displays the BCC field when you are processing a message.
Play sound on incoming mail Plays a configured sound when you receive an email.

You can configure the sound from Sounds > New Mail
Notification in the Windows Control Panel.

Show message on incoming mail Displays a notification when you receive a new email.
Close message manually Does not close the notification after the set period of time.

You must close the notification manually.
Close after Closes the notification automatically after the specified period of

time.

You can set a time between 0 and 60 seconds.
Rows Specifies the number of rows displayed in a folder.

The default value is 100 rows.
Always display paging info Displays visible scroll icons.

Showing or hiding folders
About this task
Use this procedure to show or hide specific folders. You cannot hide the Inbox folder.

Procedure
1. Click View > Visible Folders.

2. Use >> and << buttons to select which folders are shown and hidden.

3. (Optional) You can use the Up and Down arrow buttons to modify the sequence of the
folders displayed.

4. Click OK.

Configuring displayed columns and expanded status text
About this task
Use this procedure to specify which columns are displayed in a mailbox.

Email
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Procedure
1. Click View > Columns.

2. To move a column from one list to the other, select the column and then click the relevant
arrow.

3. In the Select columns list, you can use the Up and Down buttons to modify the sequence
of displayed columns.

4. (Optional) Select the Show extended state text check box to show the following
information in the Inbox, Deferred, and Overview folders:

• No answer sent ( ).

• No forwarding sent ( ).

5. Click OK.

Customizing mailbox folders
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Chapter 8: Chat

This chapter describes the chat functionality available to agents in the IP Office Contact Center User
Interface for Windows. When you sign in to your agent groups, you must select the agent group
from the Chat channel area. Otherwise, you cannot access chat functionality.

You can perform the following tasks from the Chat screen:

• View unread instant messaging (IM) notifications.

• Respond to an IM from a customer.

• Work with multiple IM conversations at a time. The default is three.

• Print an IM conversation.

• View customer details during an IM conversation.

• View completed or archived conversations.

• Add emoticons or smiley faces in an IM conversation.

• Perform a chat consult.

• Transfer a chat conversation.

Replying to a chat conversation
Procedure

1. In the Request tab, double-click a chat request to accept it.

 indicates that you have a new chat request.

2. Type a message.

Tip:

When you copy text from documents, such as Microsoft Word or PDF documents,
some characters, such as single or double quotes, might not appear properly. If you
copy text, retype these characters manually before sending your IM.

3. To send your IM, click Send ( ) or press Enter.
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Starting a chat consultation
About this task
You can perform a consultation during a chat conversation to obtain the information you need to
address a customer issue.

Procedure
1. During an active chat conversation, click .

2. In the dialog box that is displayed, select one of the following, and then click Consult:
• From Topic, select a topic.
• From Agent, select an agent.
• From Address, type an external user address, or click Addressbook to select it from an

address book.

Use the Address option if the user is not an IP Office Contact Center user. You can only
select a user from an address book if the address book has been configured by an
administrator.

After you click Consult, the consultation is added to the chat conversation.

3. (Optional) To toggle between the original chat conversation and the new consultation
session, click one of the following:

• : To continue the original chat.
• : To continue the consultation chat.

Chat transfers
You can transfer the chat to:

• The same user with whom you have a chat consultation.
• Another agent, topic, or external user if you are not on a chat consultation.

Transferring a chat conversation to the user with whom you have
a consultation

Before you begin
Start a chat consultation as described in Starting a chat consultation on page 61.

Procedure
1. If your administrator has configured mandatory or forced job codes, click  to select a job

code.

Starting a chat consultation
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2. To complete the transfer, click .

Result
The chat is transferred along with its history, for reference.

Transferring a chat conversation to any agent, topic, or external
user

About this task
This procedure describes how to perform a blind or unsupervised transfer. In this case, a
consultation is not established beforehand.

Procedure
1. During a chat conversation, click .

2. In the dialog box that is displayed, do one of the following:

• From Topic, select a topic.

• From Agent, select an agent.

• From Address, type an external user address, or click Addressbook to select it from an
address book.

Use the Address option if the user is not an IP Office Contact Center user. You can only
select a user from an address book if the address book has been configured by an
administrator.

3. Click Transfer.
Result
The chat is transferred along with its history, for reference.

Printing a chat conversation
Procedure

To print a chat in progress, click Print ( ).

Performing chat spell checks
About this task
When you reply to a chat message, you can check the chat for spelling mistakes.

Chat
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When you perform a spell check, the system displays entries that are not found in the dictionary
and suggests a replacement. You can accept or ignore the suggestions.

Before you begin
Ensure that Microsoft Office 2007 or later is installed on your computer.

Procedure

After you accept a chat request, click Spell check ( ).

From the Spellchecker dialog box that is displayed, you can view spelling suggestions, apply the
change, or ignore the change. You can also set the language for spell checks.

Setting the language for spell checks
Procedure

1. In Microsoft Word, do the following:

a. Install the language pack for the language you want to set.

b. Set proofing for the language.

From Word Options > Language, you can set the language as an editing language.

2. In the IP Office Contact Center User Interface for Windows, from the Spellchecker dialog
box, select the appropriate language and then click Apply.

Ending a chat
About this task
After an issue is resolved, use this procedure to complete or end the chat conversation. After you
end a conversation, you cannot reopen it.

Note:
After the customer or consulting agent leaves the chat conversation, you must end it in order
to become available for other chat tasks.

Procedure
1. To complete an IM conversation, click Complete ( ).

2. If job codes are required, click Allocate job code ( ) and select the appropriate job
codes.

Ending a chat
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Searching for archived conversations
About this task
After you end an IM conversation, the conversation is stored in the Archive tab.
By default, the search displays 500 entries at a time.

Before you begin
Ensure that your administrator has configured the chat archive.

Procedure
1. Click the Archive tab.

2. Search for one or more of the following and then click Use filter ( ):

• A date or time in the From or To fields.

• A customer name.

• A topic.

• An agent.

• A conversation participant.

3. (Optional) To view the complete conversation history, double-click the selected
conversation that you want to view.

The system displays all related chat conversations.

4. (Optional) To reset the search criteria, click Reset filter ( ).

Chat
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Part 2: Supervision
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Chapter 9: Realtime Information

You can access real time information on the status of an object. You can monitor some object states
in real time, and the states of other objects periodically. The states of objects are displayed
alphanumerically, graphically, or in a tabular form.

Realtime Information is organized in folders and files. You can create private or public folders. You
can also add files within a folder.

The files area displays the name and type of Realtime Information. The type indicates whether a
Realtime Information file is private or public.

Using the Realtime Information module, you can:

• Configure and view Realtime Information.
• Create, change, and delete Realtime Information folders and files.

Realtime Information provides ten templates for both agent groups and topics. These templates
contain detailed information about agent groups and topics specific to a channel. Templates have a
short description which can be edited using the Properties tab.

If you want to edit, delete, or add counters to original templates, you must create copies of the
templates and then modify them. To a duplicate template, you can add only specific element types
applicable to that particular object type. For example, if the default object type is agent group, you
cannot add a “Queue” element because it is applicable to the topic object.

Object status
You can monitor the status of the following objects in real time:

• Topics
• Agents
• Agent groups
• Teams
• IVR

Realtime Information menu option descriptions
When you open the Realtime Information module, a Realtime information menu is displayed at
the top of the screen next to the Go to menu. The following table describes the options available
in the Realtime information menu:
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Name Description
Close "Name of Realtime
Information"

Closes the current Realtime Information file.

Realtime information file list Displays the open Realtime Information file. The current Realtime
Information file is identified with a check mark.

For example:

Realtime Information 1

Realtime Information 2

Realtime Information 3
Autostart Opens the current Realtime Information file automatically the next

time you sign in.
Profile autostart Enables you to use a profile to define which Realtime Information

files will be opened automatically when you sign in. All open real
time information with the current position information is stored as
autostart Realtime Information.

Save Window Positions Saves the current window position of separate Realtime
Information.

Realtime Information views
The Realtime Information module has the following view options:

View Description
File view Displays the folders and associated files for Realtime Information. Use

this view to edit Realtime Information files.
Viewer Enables you to view Realtime Information.
Inspector Enables you to create and edit Realtime Information. When a file opens

in the Viewer mode, click Edit to edit the file in the Inspector mode.

Default monitor
If you want to start using the Realtime Information module right away, you can use the default
monitors, which are available after installation and basic configuration. The default monitors for an
agent group and topic are predefined.

Editing a Realtime Information file
Procedure

1. Open a Realtime Information file.

Realtime Information views
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2. Click Edit

The file opens in Inspector mode. You can drag element objects onto the work area, and
you can also draw lines or rectangles.

Configuring the Realtime Information file properties
About this task
Use this procedure to edit the properties of a Realtime Information file.
You can add one or more sheets in a file. To create a Realtime Information sheet for a certain type
of object, you must select the correct default type in the sheet properties. For example, if you
select agent groups as the default type, you can only create Realtime Information elements for
agent groups on this sheet.

Procedure
1. Click Properties.

To access a Realtime Information file from the Home or Telephony modules, click File view
from the Home or Telephony menu.

2. In the Properties window, click the Realtime information files tab and do the following:

a. In Name, type a name for the file.

The file name can contain up to 29 alphanumeric characters.

b. (Optional) To use a file name for the default object type, in Type of default, choose
an object and then select Use default type only.

You can add only object specific elements to the work area. If you clear Use default
type only, you can add any element. If you choose the object type “None”, you
cannot select Use default type only . However, you can add any element to the work
area irrespective of the object type.

c. To configure the size of the work area, type a width and height from 160 to 3000
points.

To view real time information in full screen mode, configure the size of the work area
according to the resolution of your monitor. If the size of the work area exceeds the
window size, you cannot see the scroll bar.

3. Click the Description tab to enter a description for the file.

This description can contain up to 256 characters.

4. Click the Realtime information sheet tab, and do the following:

a. In Name, type a name for the sheet.

b. To display a grid in the work area, select Grid.

c. (Optional) If you have enabled a grid, enter width and height values.

Realtime Information
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The range for the grid width and height is from 2 to 50 points and determines the
spacing of the grid.

5. Click the Presentation tab, and do the following:

a. In the Font area, configure the font display.

b. In the Line area, configure the line width and color.

c. In the Background area, select a background color or a background image.

6. Click OK.

7. (Optional) To add multiple Realtime Information sheets, at the bottom of the work area,
right-click the page tab and click Add page.

If required, configure the properties for the new page. Each sheet has a corresponding tab.
You can drag and drop to change the order of the Realtime Information sheets. You can
also right-click to add, copy, or delete a sheet.

Drawing a line or rectangle
About this task
Use this procedure to draw lines or rectangles in the work area of a Realtime Information sheet.
For example, you might want to use lines to connect elements. You can select more than one
element, line, and rectangle, and move them together, but you cannot group them permanently.

Procedure
1. In the editable Inspector mode, click one of the following:

•  to draw a line.

•  to draw a rectangle.

2. Use the grid on the sheet to position the line or rectangle as needed.

Switching on the selection mode
About this task
Use this procedure to toggle from Drawing mode to Selection mode.

Procedure
1. In the editable Inspector mode, click Selection mode ( ).

2. To toggle to the draw mode, click  again.

Editing a Realtime Information file
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Changing the color, line type, and line width
Procedure

1. Right-click a line on the sheet and click Properties.

2. In the Properties dialog box, do the following:

a. In Line type, click the line icon .

b. Select a line width from 0.5 to 6 points from the drop-down menu.

c. Click Color ( ) to choose a color from the Color selection menu.

Selecting and deleting elements from a Realtime Information file
Procedure

• To select multiple elements or objects on a Realtime Information sheet, do one of the
following:

- Keep the Ctrl key pressed and click the required elements.

- Draw a selection frame around the required elements.

• To delete an element, do the following:

1. Right-click the element and click Delete.

2. Confirm your selection if prompted.

Realtime Information elements
This section describes the elements that can be used with the Realtime Information module.
Realtime Information elements are displayed in the Inspector view.

Element types
Each element contains options that you can drag onto the work area for a Realtime Information
file.

Text element options
The following table describes the options available with the Text element:

Realtime Information
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Element option Purpose Customization options

Label ( ) To add a title or label for a
designated area.

You can adjust the:

• Size

• Text properties

Value ( ) To provide a value and an
abbreviation of the value.

You can:

• Adjust the size.

• Select an object.

• Hide the label or abbreviation.

• Change the text properties and
background color.

Longest Wait Time (topic) ( ) Two options are available. One is
for Telephony and the other is for
Email.

Use these options to show the
longest waiting time for topics.

You can change the text
properties and background color.

Hyperlink ( ) To link multiple Realtime
Information sheets with
references.

You can:

• Adjust the size.

• Type the text to display.

• Change the text properties and
background color.

• Select a real time information
element file, a real time
information sheet, or a URL as
the link.

Email to contact ( ) To send an email to a contact or a
caller. You can use this function
for example, in telephony screen
to send an email during
conversation or wrap up to the
actual calling party. The To
address and Subject can be
configured with tags.

You can:

• Adjust the size.

• Change the text properties and
background color.

• Hide the borders.

• Create tags for the To and
Subject fields.

Out of office notice ( ) For agents to display an out of
office notice, which supervisors
can see on their Home screen.
Only a signed in agent can enter
an out of office notice.

You can:

• Adjust the size.

• Hide the title.

• Select an agent or <Default>.

• Change the text properties and
background color.

Table continues…
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Element option Purpose Customization options
• Hide the borders.

Variable ( ) To select a variable and configure
properties for the variable. For
more information about
configuring these variables, see 
Setting values for the Variable
element on page 72.

Configure the following options in
the Selection tab:

• Select the Can be edited check
box.

• Select the Display as marquee
check box.

• Configure values.

You can also:

• Adjust the size.

• Change the text properties and
background color.

• Hide the borders.

Tag ( ) To display all tags for received
calls.

Tags are informational units
attached to calls and consist of
values or text. There are two
types of tags: system tags and
user-defined tags. The system
tags are prepared in the IP Office
Contact Center system and are
always attached to a call.

You can:

• Select a tag.

• Change the display name.

• Choose whether a value can be
edited.

• Change the text properties and
background color.

• Hide the borders.

• Adjust the size.

Setting values for the Variable element
Procedure

1. Drag the Variable element onto the work area and click Properties.

2. In the Properties dialog box, in the Select variable area, click .

3. In the Variable selection dialog box, choose an object, and then click OK.

4. (Optional) Select Can be edited.

5. (Optional) Select Display as marquee.

6. Select Values and do one of the following:

• Type the minimum and maximum values.

• Use the horizontal or vertical sliders.

7. Click OK.

Realtime Information
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Lists options
The following table describes the options available with the Lists element:

Element option Purpose Customization options

Agent status list ( ) To display the agent status for an agent
group or team.

The supported task types for an agent
group (AG) and a team are:

• Telephony

• Email

• Chat

Drag the Agent status list options you
want onto the work area.

Note:

The work area for Agent status list
options displays maximum 100
agents.

Following options are available for this
option:

• Name: shows the agent’s name

• Login state: shows the agent’s login state.
The following states are indicated in this
option:

- No display: Agent is not logged in

- Pres: Agent is logged in

- Si-on: Agent is signed in

- Blocked: Agent is signed in, but cannot
receive any more tasks. The maximum
number of tasks can be configured from
System > Availability for Tasks in the
Configuration module. In the Availability
for Tasks tab, you can also indicate
which tasks agents can perform
simultaneously. For example, if your
configuration indicates that an agent
cannot receive a chat request while on
a call, then the agent will be blocked for
chat during a call.

- ACD: Agent is signed in to call
distribution

- P: Agent is on a break

You can:

• Adjust the size.

• Select an agent group or
<Default>.

• Hide the title.

• Display information to
authorized users only.

• Select the display content
of all agents or only
present agents.

• Customize the column
arrangement.

• Change the text
properties and
background color.

Table continues…
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Element option Purpose Customization options
• Work state: shows the agent’s work state.

The following states are indicated in this
option:

- Avail (agent is available)

- FOC (force job code input)

- Busy (busy, no ACD call)

- ACD (ACD conversation)

- ACW (wrap up)

• A.state.dura: duration or current agent
state

• TNo.: shows the number of the telephone
where agent is logged in

• Break code: shows the reason code for a
break

• Outoforder: shows that the agent is no
longer available

• Reserve: shows the name of the agent
the task is reserved for

• Term state: shows the state of the
terminal. The following states are
indicated:

- Available (no call, available agent)

- Off-hook (the handset is off-hook)

- Call (call)

- Conn (connection)

- Hold (connection is on hold)

- bTone (busy tone)

- Fault (terminal fault)

• int/ext: shows eitehr int for internal
connection or ext for external connection

• Direction: shows either incom for
incoming or outg for an outbound
connection.

• ACD: shows whether the call was
distributed through call distribution

• Topic: shows the topic the agent is
currently working for

Table continues…
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Element option Purpose Customization options
• AG: shows the agent group the agent is

currently working for (call was routed
through this AG)

• Task dura: shows the current duration of
the displayed task state

You can also interact with the agents in the
following list:

• Sign on to AG: you can sign the agent on
to an agent group (telephony and email)

• Sign out of AG: you can sign the agent
out of an agent group (telephony and
email)

• Login: you can log the agent in on a
telephone

• Logout: you can log the agent out of
telephone

• Pick up: you can pick up a call

• Out Of Office: you can enter a out-of-
office notice in a dialog box

• Pause: you can set an agent to pause.
When a pause code is required you can
enter a pause code in a sub menu.

• End pause: you can end the pause of an
agent

Queue ( ) To configure information for calls, emails,
and IM chats displayed in the queue. The
following types of data for call can be
displayed in a column:

• No.: phone number of caller

• Topic: dialled in topic

• Line: line number (not available in
IPOCC)

• TT: time in topic

• Announcement: kind of connected
announcement (none, interruptible, non-
interruptible)

• Announc scripts: name of connected
announcement

• TCS: time in current state

You can:

• Adjust the size.

• Select a topic or
<Default>.

• Hide the title.

• Customize the column
arrangement.

• Change the text
properties and
background color.

Table continues…
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Element option Purpose Customization options
• reserv.for: name of agent this entry is

reserved for

• Tag: you can select one or more tags

The following types of data for email can be
displayed in a column:

• Address: email sender

• Topic: addressed topic

• Twait: wait time of email

• reserv.for: name of the agent this entry is
reserved for

• Tag: you can select one or more tags

The tag display retains its value when a
call, email, or chat conversation enters the
queue.

Conversations per AG
(topic) ( )

To display the number of established calls
for the selected topic broken down into
agent groups (AG).

The values are reset to 0 at the end of the
calculated period, such as TSF, which is set
to 100% at the end of the configured time
frame.

You can:

• Adjust the size.

• Select a topic or
<Default>.

• Hide the title and total
line.

• Display information to
authorized users only.

• Change the text
properties and
background color.

Number of opened emails
per AG (topic) ( )

To display the number of open emails
(totNAccE) for the selected topic broken
down into agent groups (AG).

The values are reset to 0 at the end of the
calculated period, such as TSF, which is set
to 100% at the end of the configured time
frame.

You can:

• Adjust the size.

• Select a topic or
<Default>.

• Hide the title and total
line.

• Display information to
authorized users only.

• Change the text
properties and
background color.

Skill combination ( ) To display skill combinations. You can:

• Adjust the size.
Table continues…
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Element option Purpose Customization options
It shows the information of the amount of
calls which have a set (combination) of
skills attached, it also shows how many
calls with the requested skills combination
are served, not served or served after skill
reduction.

• Select a topic or
<Default>.

• Hide the title and total
line.

• Customize the column
arrangement.

• Display information to
authorized users only.

• Change the text
properties and
background color.

Abandoned call list ( ) To display abandoned calls for the selected
topics.

It shows the caller number, date and time of
the last call, shows whether caller hang of
or was dropped by task flow.

You can call back the caller from the call list
by double-clicking the entry.

You can:

• Adjust the size.

• Select a topic or
<Default>.

• Hide the title and total
line.

• Customize the column
arrangement.

• Change the text
properties and
background color.

• Print the call list.

Tables element options
The following table describes the options available with the Tables element:

Element option Purpose Customization options

Agent group table ( ) To display agent group
information.

For more information, see Agent
group values on page 89.

You can:

• Adjust the size.

• Change the text properties and
background color.

• Hide the title, total line, and
details.

• Display information to
authorized users only.

• Select one or more agent
groups.

Table continues…
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Element option Purpose Customization options
• Customize the column

arrangement.

Dialer table ( ) To display agent, topic, or
campaign dialers.

For more information, see Dialer
table values on page 90.

You can:

• Adjust the size.

• Change the text properties and
background color.

• Hide the title, total line, and
details.

• Select agent, topic, or
campaign details.

• Customize the column
arrangement.

Topic table ( ) To display topic information.

For more information, see Topic
values on page 86.

You can:

• Adjust the size.

• Display information to
authorized users only.

• Change the text properties and
background color.

• Hide the title, total line, and
details.

• Select one or more agent
groups.

• Customize the column
arrangement.

IVR overview ( ) To display IVR information. You can:

• Adjust the size.

• Change the text properties and
background color.

• Hide the title, total line, and
details.

• Customize the column
arrangement.

Hiding the total in table elements
About this task
With Tables elements, you can display or hide total values.

Procedure
1. Right-click the element.

Realtime Information
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2. In the pop-up menu, click Properties.

3. In the Properties dialog box, select Hide total.
4. Click OK.

Customizing table arrangement
About this task
You can adjust the arrangement of columns in a table.

Procedure
1. Right-click the element.

2. In the pop-up menu, click Properties and do one of the following:

• Click  to move information from Available information to Visible information.

• Click  to move information from Visible information to Available information.

• Click Up or Down to move information up or down.

3. Click OK.

Graphics elements options
The following table describes the options available with the Graphics elements:

Element option Purpose Customization options

Image ( ) To insert an image in one of the
following formats:

• *.bmp
• *.jpg
• *.gif
• *.png

You can:

• Adjust the size.

• Select a graphic file.

• Hide the borders.

• Choose a title.

Group ( ) For graphically combining
multiple elements.

You can:

• Adjust the size.

• Hide the title.

• Specify the title.

• Change the font properties and
background color.

Bar chart ( ) To display values in a bar chart
format.

If a value exceeds a certain limit,
the system changes the bar color.
The bar turns yellow in the event
of a warning. The bar turns red in

You can:

• Adjust the size.

• Hide the title.

• Specify the title.

Table continues…
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Element option Purpose Customization options
the event of an alarm. The
threshold points display in a
dotted line.

• Change the font properties and
background color.

• Select a value.

• Select an object such as an
agent group.

Longest Wait Time (topic) ( ) To display the longest waiting
time for the selected topics. The
supported task types are:

• Telephony

• Email

You can:

• Adjust the size.

• Hide the title.

• Change the font properties and
background color.

• Select topics.
Queue (topics) [Telephony]
( )

To display the number of calls in
the queue for the selected topics.
The waiting calls of all selected
topics are added up.

You can:

• Adjust the size.

• Hide the title.

• Change the font properties and
background color.

• Select topics.

Waiting emails (topics) ( ) To display queued or waiting
emails for the selected topics.

You can:

• Adjust the size.

• Hide the title.

• Change the font properties and
background color.

• Select topics.

Individual status LED ( ) To display the status of a single
value or object for an agent
group. You cannot set conditions
to display multiple values for an
agent group.

The event is displayed as an LED
indicator. If the value exceeds a
certain limit value, the LED
indicator changes color and
shape.

You can:

• Adjust the size.

• Hide the title.

• Change the font properties and
background color.

• Select an object, for example,
Agent group.

• Select a value for the object
such as the number of active
agents.

Individual status parser ( ) To display the status of multiple
values or objects for both agent
groups and topics.

You can:

• Adjust the size.

• Enter and hide the title.
Table continues…
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Element option Purpose Customization options
The event is displayed as an LED
indicator. If the value exceeds a
certain limit value, the LED
indicator changes color and
shape. For more information
about parser properties, see 
Configuring parser properties on
page 82.

• Change the font properties and
background color.

Pie chart ( ) To display values for individual
agents or agent groups in a pie
chart format. You can select the
following values for the pie chart:

• Overview for an agent
(telephony and email)

• Overview for an agent group
(telephony and email)

With this element, you can:

• Adjust the size.

• Hide the title.

• Select an agent or an agent
group as the object.

Agent status (AG) ( ) To display the agent status for an
agent group and team. You can
choose whether all agents or
preset agents only are displayed.

A button is assigned to each
agent. The color of the button
indicates the state of the agent.
The states displayed in the
Realtime Information element are
preset. You can also use the
buttons for special actions, such
as signing in and out or double-
clicking to call an agent.

You can:

• Adjust the size.

• Hide the title.

• Change the font properties.

• Select the agent group or team.

• Adjust the skill filter.

• Select the number of columns.

Phone state ( ) To display the status of phones,
that are members of the selected
telephone group. You can make a
call by double-clicking the phone
number.

You can display the number of
each phone or the name in the
telephone group.

Active agents (AG) ( ) To display active agents.

An agent is active when a topic
call is ringing, during a
conversation for a topic call, in
wrap up time, or when forced to
enter a job code. An agent is not
displayed as active when
handling a non-topic call.

You can:

• Adjust the size.

• Hide the title.

• Change the Axis label
properties.

• Change the background and
chart color.

• Select an object.
Table continues…
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Element option Purpose Customization options
The graphic display enables you
to observe how values change
with time.

The time displays on the X-axis
(T) and the range of the value on
the Y-axis. A curve displays the
progression. The title displays the
object and the Realtime
Information name.

Related links
Agent status indicators on page 82

Configuring parser properties
About this task
Use this procedure to configure the parser properties for a warning and an alarm.

Procedure
1. Drag the Individual status parser element onto the work area and click Properties.

2. In the Properties dialog box, click the Parser configuration tab.

3. (Optional) In Name, type a name.

4. Place your cursor in the box under Warning or Alarm, and then do the following:

a. Click Variable.

b. In the Variable selection dialog box, double-click an object to add.

5. In the Objects area, click:

• AG to choose an agent group.

• Topics to choose a topic.

6. In the Operators tab, double-click an operator.

The system displays the operator value in the Warning field.

7. Enter a value.

You must enter a whole number. To enter a duration, specify a value in seconds, such as
240 for 4 minutes.

8. Click OK.

Agent status indicators

In the display range, click the Legend icon  to display a list of the different agent statuses. You
can customize the key color for every agent.
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Other elements options
The following table describes Other elements options:

Element option Purpose Customization options

Agent history ( ) To display processed customer
contacts and relevant contacts for
call, email, and chat requests.

—

Remote functions ( ) To remotely control agent actions.

If the agent is logged in on a
terminal, the physical number of
the terminal and the configured
agent groups are displayed. You
can log agents in or out of agent
groups. You can also force an
agent to go on break or end an
agent's break.

You can:

• Adjust the size.

• Change the font properties.

Internet browser ( ) To add a browser link.

You can specify a fixed URL or
determine the URL with a tag.
Use the following format for the
URL tag: xyz%TAGNAME%xyz .

You can:

• Adjust the size.

• Hide the title.

• Enter a URL or use a tag.

Supervisor Emergency ( ) The Supervisor Emergency
element has two types of support,
silent monitoring and active
participation in the call. The
Supervisor Emergency element
notifies the supervisor of the
agents that require support. The
IP Office Contact Center User
Interface for Windows activates a
signal on the supervisor interface
when an agent requests
supervisor support. If the
supervisor is available, the agent
can get supervisor assistance. A
supervisor can only provide active
support to one agent at a time.

Important:

Supervisor Assistance and
Coaching is not currently
supported in IP Office
Contact Center.

You can:

• Adjust the size.

• Hide the title.

• Insert or delete agent groups or
agents, and sort them using the
Up or Down buttons.

• Select the display content of all
agents or only the agents
present.

• Set or automatically display the
number of columns.

• Change the font properties and
background color.

• Use a scroll bar.
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Working with remote functions
Logging agents in and out of a terminal

Procedure
1. Right-click the agent.

2. To log an agent in, do the following:

a. Click “agent” log in.

b. In the Telephone selection dialog box, click Terminal or Telephone number.

Busy terminals are not listed.

c. Click OK.

3. (Optional) To log an agent out, do the following:

a. Right-click the agent and select Log out "agent”.

b. Click OK.

Signing an agent in and out of agent groups in the terminal

About this task
Use this procedure to sign an agent in and out of all assigned agent groups or specific agent
groups.

Procedure
1. Right-click the agent.

2. To sign an agent in, do one of the following:

• Click Sign on "agent" to all AGs to sign an agent in to all agent groups.

• Select the appropriate agent groups to sign an agent in to specific agent groups.

3. To sign an agent out, do the following:

• Click Sign off "agent" from all agent groups to sign an agent out from all agent
groups.

• Clear the check boxes for specific agent groups.

Element customization
Inserting and deleting objects

About this task
You can insert or delete objects in certain Realtime Information elements. You can also customize
the order of objects.
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Procedure
1. Drag and drop an element onto a Realtime Information sheet.

2. To insert an object in the Realtime Information element:

a. Click Properties.
b. In the Properties dialog box, click Add.
c. In the Topic Selection dialog box, click the appropriate objects.
d. Click OK.

3. (Optional) To delete objects, click the appropriate objects and click Delete.

4. (Optional) To change the order of objects, use the Up and Down buttons.

Changing the size of elements
Procedure

1. Click the border of the element.

2. Use the mouse to drag and drop the border to enlarge or reduce the size.

Important:

You cannot change the size of all Realtime Information elements.

Background display setting
You can change the background color for some Realtime Information elements.
The Show borders option displays the Realtime Information element with a border. You can also
select a background image for certain elements.
You can select the following from a palette:

• The labeling of the text color
• The line color
• The background color

Hiding an element title
Procedure

1. Right-click the element.

2. In the pop-up menu, click Properties.

3. In the Properties dialog box, clear the Show title check box.

4. Click OK.

Configuring the number of columns
About this task
You can control the number of columns automatically or define a set number of columns for some
real time information elements.
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Procedure
1. Right-click the element and click Properties.

2. In the Properties dialog box, in Number of columns, select one of the following:

• Automatic: To set the number of columns automatically.

• n columns: To customize the number of columns displayed according to the specified
value for n.

3. Click OK.

Configuring the presentation settings
Procedure

1. Right-click the element and click Properties.

2. In the Properties dialog box, click the Presentation tab.

3. To configure the Presentation settings, do the following:

a. Select Font and choose a font type and size.

b. Select Background and choose a color from the palette.

4. Click OK.

Values
You can set counter values for some element options, such as the following:

• Value element option under Text element
• Bar chart and Individual status options under Graphics elements

Topic values
Counter abbreviation Description Supported task types
avgTQueued The average wait time of tasks in the

queue.
• Telephony [T]

• Email [E]

• Chat [C]
avgTQueuedInterv The average wait time during an

interval.
Telephony [T] only

avgTAbanWaitShift The average time that the callers
waited before the call was abandoned.

Table continues…
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Counter abbreviation Description Supported task types
avgTConvWaitShift The average speed of answer per shift.
AcceptLevel The acceptance level.
AcceptLevelShift The acceptance level of the whole

shift.
maxTQueued The maximum wait time. • Telephony [T]

• Email [E]

• Chat [C]
nReserved The number of reserved tasks. Telephony [T] only
NQueued The number of tasks in the queue. • Telephony [T]

• Email [E]

• Chat [C]
NQueuedAnnNotInt The number of waiting calls with none

interruptible announcement.
Telephony [T] only

NVoiceMails The number of voice mails.
totNAbanDyn The number of unanswered calls

based on a dynamic calculation.
totNAbanInterv The number of unanswered calls for an

interval.
totNDoneShift The number of completed

conversations or activated emails or
chats per shift.

• Telephony [T]

• Email [E]

• Chat [C]totNNewShift The number of calls per shift.
totNtransExtDestShift The total number of calls per shift

transferred to another topic and to an
external destinations.

Telephony [T] only

totNDoneExtDestShift The number of completed
conversations with external
destinations per shift.

totNExtDestShift The number of calls with external
destinations per shift.

totNOverload The overload per shift.
totTVoiceMails The total length of voice mails.
totNDoneOutCCShift The number of conversations per shift.
totNAbanShift The abandoned calls per shift.
totNAbanOutCCShift The number of abandoned outgoing

calls per shift.
totNOutCCShift The number of calls per shift.

Table continues…
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Counter abbreviation Description Supported task types
totFDoneInterv The processing factor. This is the ratio

of processed to deleted tasks.
• Telephony [T]

• Email [E]
totNTSF+ The total number of positive calls or

emails for the TSF calculation.

Positive calls result in a discussion.
Positive emails are closed emails.

totNdoneInterv The number of processed tasks during
the period under consideration.

totNTSF The total number of requests for the
TSF calculation.

TSFDyn The Task Service Factor (TSF)
dynamic calculation.

• Telephony [T]

• Email [E]

• Chat [C]
TSF The current TSF.

TSFShift The service level over the shift. Telephony [T] only
totNAutoAgentShift The number of calls processed by an

AutoAgent IVR script.
totNCallbackShift The number of callbacks according to

the queue position per shift.

Agent values
Counter abbreviation Description Supported task types
avgTBreakShift The break time average per shift. Telephony [T] only
avgTConvShift The average Automatic Call

Distribution (ACD) conversation time
per shift.

avgTWrapUpShift The average wrap up or After Call
Work (ACW) time per shift.

This counter only counts incoming
topic calls.

avgNConvPerHourShift The average number of ACD
conversations per hour related to the
time when an agent is signed in per
shift.

totTBreakShift The total break time per shift.
totTConvShift The total ACD conversation time per

shift.
totNNewShift The total number of calls per shift. • Telephony [T]

Table continues…
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Counter abbreviation Description Supported task types
• Email [E]

• Chat [C]
totTWrapUpShift The total wrap up or ACW time per

shift.

This counter only counts incoming
topic calls.

Telephony [T] only

totTSignOnShift The total time per shift during which
an agent is signed on.

totNOutCCShift The total number of outgoing ACD
calls.

totNAbanOutCCShift The total number of outgoing ACD
calls that were unanswered by the
destination.

totNDoneOutCCShift The total number of outgoing ACD
calls that were answered by a
destination.

totNDoneShift The total number of conversations or
activated emails or chats per shift.

• Telephony [T]

• Email [E]

• Chat [C]

Agent group values
Counter abbreviation Description Supported task types
avgNFree The average number of available

agents.
• Telephony [T]

• Email [E]
avgNAct The average number of active agents.
avgNNew The average number of calls through

call distribution.
Telephony [T] only

avgNAcc The average number of conversations
through call distribution.

avgNWrapUp The average number of agents in
wrap-up time.

avgNFJCode The average number of agents with
mandatory job code.

avgNNew The average number of agents with
unopened emails.

Email [E] only

avgNAcc The average number of agents with
opened emails.
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Counter abbreviation Description Supported task types
NNew The number of agents with unopened

emails.
NAcc The number of agents with open

emails.
NSignOn The number of signed in agents. • Telephony [T]

• Email [E]
• Chat [C]

NFree The number of available agents.
NAct The number of active agents.
NBreak The number of agents on break.
NNew The number of new calls through call

distribution.
Telephony [T] only

NAcc The number of conversations through
call distribution.

NWrapUp The number of agents in wrap up or
ACW time.

NFJCode The number of agents with mandatory
job code selection.

Team values
Counter abbreviation Description Supported task types
totNTSF+ The total number of positive calls and

emails for TSF calculation.

Positive calls resulted in a discussion.
Positive emails are closed emails.

• Telephony [T]

• Email [E]

totNTSF The total number of calls and emails in
the TSF calculation.

TSF The current TSF.

IVR values
Counter abbreviation Description Supported task types
NBusyIVRPorts The number of assigned IVR

ports.
Telephony [T] only

Dialer table values
The following information is available in the Dialer table.
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Counter abbreviation Description Supported task types
%CompletedJobs Share of processed jobs. Telephony [T] only
curDropRate Current drop rate percentage.
CurDialFactor Current dial factor percentage.
maxDropRate Percentage of configured drop rate

(default values).
NAbandonedJobs Number of call connections

cancelled by the external party
before they were answered.

NBusyDestJobs Number of calls during which the
external party was busy.

NInitJobs Number of initiated jobs.
NCanceledJobs Number of dial attempts canceled

due to exceeded ring timeout
(destination not reached).

NDroppedJobs Number of call connections that
were automatically cancelled by the
system due to unavailability of
agents.

NUnfinishedJobs Number of incomplete jobs. These
are dialed jobs that are not in the
“Ended” or “Failed” state.

NTriesJobs Number of dial attempts.
NClosureJobs Number of closure contacts

(connection between an agent and
the called party).

NRPCJobs Number of Right Party Contacts
(RPC).

NRawJobs Number of unprocessed jobs that
were not dialed.

totNJobs Total number of jobs.

Realtime information window settings and calculations

Working with detached monitors
Procedure

1. Select a monitor to detach.

2. Click File > Open > In the same Window
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3. Click Save.

Detached monitor field descriptions
You can set the following properties in the system menu field.
A check mark is used to indicate which functions you can use.

Function Description
Always in the
foreground

Indicates that the monitor must always remain visible in the foreground, even if
you use another Windows application. Avaya recommends only important
monitors remain in the foreground.

You can also adjust the size of the monitor.
Prevent minimization Prevents the monitor from being minimized.
Prevent closing Prevents the monitor from being closed. When you exit the IP Office Contact

Center User Interface for Windows, the monitor also closes.

Realtime Information states
The values and states of Realtime Information elements can be displayed periodically or as a
sliding window, depending on the element.

Real time display
The system updates the Realtime Information continuously. The values match the current values
in the IP Office Contact Center system. Information and values are sent from the server to the
Realtime Information element if a change occurs. The element then displays the changed
information or values.

Periodic updates
The system updates information and values after 10 seconds in a periodic update. The period of
10 seconds is predefined for the IP Office Contact Center system and cannot be changed.
Periodic updates are used for tabular elements.

Sliding window
A sliding window means that after each update interval, the calculated period of time moves one
update interval. A period of 10 seconds is set for the update interval of the IP Office Contact
Center system and cannot be changed.

Example
The following example displays the progress of a sliding window with stop and start times. This
example shows a calculated period of 15 minutes that is updated at an interval of 10 seconds.

Calculation Start Stop
1 11:00:00 AM 11:15:00 AM
2 11:00:10 AM 11:15:10 AM
3 11:00:20 AM 11:15:20 AM
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Saving the settings of the current window arrangement
About this task
The Realtime Information that is currently on display can be opened automatically the next time
that you sign in with the same settings.

Procedure
Do one of the following:

• Click Save Window positions
• Click Autostart.

Realtime Information calculation
Realtime Information displays different current and average values. Conditions for certain
calculations are set in the Configuration module.
Average values have a fixed update interval of 10 seconds. Individual values are recorded every
second. The system determines and updates the average at the end of the update interval.
The formula for average values is: A = (V1+V2+V3+V4+V5+V6+V7+V8+V9+V10)/I
The following table defines the elements in this formula:

Element in the formula Description
A Calculated average.
V1 to V10 Individual values that are recorded every second.
I Update interval of 5 seconds.

Wait time
The wait time of a task depends on the task type.

• The wait time of a call starts from the time that the call is queued in the topic queue.
• The wait time of an email starts from the that time the mail arrives in the topic mailbox.

Acceptance Level
The formula for the acceptance level is: Incoming calls / (received calls - short
calls)
A call without a conversation with a waiting time of <N sec [default: 5 sec] is defined as a short
call.

TSF calculation
The Task Service Factor (TSF) displays the percentage of tasks that have been waiting in a queue
for less than or equal to the wait time threshold. The wait time threshold for the TSF is set in the
Configuration module for topics, agent groups, and teams. Different thresholds can be set
between 5 to 900 seconds or 15 minutes. For topics, you can set a threshold for short abandoned
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calls, which have a short wait time, because the configured values are not considered in the TSF
calculation. All tasks in the queue, including those waiting for longer than the calculated period set,
are taken into account.
In contrast to the Dynamic Task Service Factor (DTSF), the TSF is reset to 100% after each
calculated period. The calculated period is valid for the entire IP Office Contact Center system.
The TSF is recalculated and updated after each update interval.

DTSF calculation
The Dynamic Task Service Factor (DTSF) displays the percentage of tasks that have been waiting
in a queue for less than or equal to the wait time threshold. The wait time threshold is set in the
Configuration module for topics and agent groups. Different thresholds can be set between 5 to
900 seconds or 15 minutes.
A DTSF of 75% means that 75% of all tasks were in the queue for a time less than or equal to the
defined wait time threshold. All tasks that have been waiting longer than the calculated period set
in the queue are taken into account for the DTSF. The calculated period is valid for the entire IP
Office Contact Center system.
The DTSF is updated after each update interval. The DTSF is a sliding window that is updated
after every interval of 10 seconds. The calculated period moves along the time axis for one update
interval.

TSF and DTSF calculation
The formula is:

• TSF= N / S * 100
• DTSF= N / S * 100

The following tables defines the elements in this formula:

Element in the
formula

Description

TSF or DTSF Task Service Factor or Task Service Factor (Dynamic calculation).
N Number of tasks less than or equal to the wait time threshold during the calculated

period of time.
S Total of all tasks during the calculated period of time.

Customization of real time information for the Home and
Telephony modules

When you have the privilege “Select own home file” or “Select own telephony file”, you can select
a Home or Telephony file to display. The preconfigured file contains Realtime Information objects
that provide system status information. When you have the higher level privilege “Home
configuration” or “Telephony configuration”, you can configure the objects in these modules.
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Selecting a Home or Telephony file
Procedure

1. Open the Home or Telephony screen.

2. Depending on the module you choose, click one of the following:

• Home > Select home file.

• Telephony > Select telephony file.

3. In the File Selection window, click a folder and then click a file.

4. Click Select.

Creating a Telephony quick bar file with customer history
information

Procedure
1. Open the Telephony screen.

2. Click Telephony > File view.

3. Click New quick bar file.

4. Type a file name for the New quick bar file created in the Telephony files area.

5. Select the file and click Edit.
6. From the Telephony inspector dialog box, drag the “Customer history” element into the

work area.

7. In the Properties: Customer History dialog box, choose a period.

The period that you select determines which contact data is displayed in the customer
history. The starting point is always from the current time. If you specify 0, then all existing
data is displayed. This can also result in the display of a large amount of data and can
cause delays.

8. Choose the required tabs from the Invisible columns area and add them to the Visible
columns area.

9. Click OK.
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Redirecting or picking up a call or a chat conversation
About this task
This procedure describes how a supervisor or team leader can pick up a call or chat conversation,
or redirect it to another user.

Note:
If a quick bar is configured, agents with the appropriate privileges can also perform pickup and
redirect operations from any Agent screen.

Before you begin
• You must have the appropriate privileges, which are “Redirect”, “Redirect from Queue”, and

“Pick up”. For more information about privileges, see Using the Avaya IP Office Contact
Center Configuration and User Interface Configuration Modules.

• To pick up a call or chat conversation, you must be signed in to an agent group with
telephony or chat, and your status must be “Available”.

Procedure
• To pick up a call, select the appropriate row in the call queue or the Agent Status area in the

Realtime Information or Telephony screen, and then click Pick up.

• To pick up a chat conversation, select the appropriate row in the chat queue or the Agent
Status area in the Realtime Information screen, and then click Pick up.

• To redirect a call, drag the call from the queue or the Agent Status area in the Realtime
Information or Telephony screen, and drop it onto an available agent.

• To redirect a chat conversation, drag the conversation from the queue or the Agent Status
area in the Realtime Information screen, and drop it onto an available agent.
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Chapter 10: Reporting

Using Reporting, you can record and examine all important IP Office Contact Center data. IP Office
Contact Center provides detailed information about important events in the form of report data.
Additional report data is calculated from agent statuses, emails, voice mail messages, and
announcements.

Advantages of reporting
You can use Reporting to:

• Ensure continuous quality of service.
• Identify peak times that can be counteracted by proper coordination among contact center

personnel.
• Evaluate performance and calculate expenses for the time needed to process a call or email.
• Use the information from reporting evaluations as a basis to assess and respond to seasonal

events or increase in customer requests.
• Record feedback about promotions and marketing measures.

Reporting data
Reports can be generated manually or automatically.
Reporting gathers and classifies numeric data and other information, such as job codes and skill
combinations for defined objects, such as agents, topics, and agent groups. You can also create
records of individual telephone conversations.
The database stores all report values. The recorded data is the basis for further evaluations or
special algorithms. You can collect data and evaluate results using the report generation server and
report viewer components.
You can configure two types of reports:

• Private: For only the user who defined the report.
• Public: For all users with privileges to view reports.

You must define a time frame for the report survey.
A report can be displayed in a tabular or graphical format.

Note:
• You cannot copy and paste reports between predefined folders.
• In the report view, you can use the toolbar to directly export, print, and send reports

through emails.
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Reporting methods
You can either use interval-based or back office reporting.

Note:

Do not use both reporting methods together.

Interval-based reporting
Counters are presented as events on the time axis. If a counter exceeds the interval, the counter
counts proportionally for each interval. Logical totals are necessary to determine the actual
number of events for the period under consideration. Within an interval, counters can be verified
according to specific rules, and the actual times, such as ring times or conversation times, are
saved.

Back office reporting
All report values, such as counters, times, and job codes, are determined for the report interval
during which the call was first recognized by the IP Office Contact Center system. This is the time
stamp of the first event received by the kernel process per call. Times that exceed the duration of
the interval are written to the first interval. Further intervals for the event are not recorded.
Consultation calls are considered to be special cases. For consultation calls, the system creates a
new call. The consultation call does not need to start in the same interval as the original call. All
report values for the consultation call and a possible transfer are recorded for the interval in which
the consultation call was started.
Back office reporting does not require logical totals because the technical and logical totals are the
same.

Conditions for calls and conversations
You must consider the calculated period when you count calls and conversations.
For interval-based reporting evaluations, select the resolution of the time axis and the calculated
period. Follow this condition for all calculations. This condition also applies to the subtotal, total
data, and exported data.
With back office reporting evaluations, totals are assigned to the period in which the call entered
the system.

Time
The following table explains the time calculation:

Reporting
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Time Description
Calculated period of time Set in the Configuration module. The system saves the data after each

calculated period and determines the resolution of the data.
Resolution of time axis Months, weeks, days, total period, or user-defined hours and minutes

are used as the time axis resolution. The minimum value is the
maximum calculated period within the period that you select.

Duration of ring time, wrap up
time, total processing time,
conversation time, calls in the
queue, and calls on hold

These counters count the periods in which the event occurs for interval-
based reporting, or the first period under consideration for back office
reporting.

Numbers
The following table explains the calculation of totals in interval-based reporting:

Item counted Description
Calls Calls are counted for the calculated periods, during which they are connected to

a terminal. If a call connects during two calculated periods, it is counted for both
periods.

Conversations Conversations count for the calculated periods during which they occur. Only the
duration of a conversation during the period under consideration is taken into
account.

If a call continues for more than one calculated period, it counts for all periods.
You must take this count into consideration for technical subtotals and totals.
Logical totals display the number of established calls because the whole period
under consideration is taken into account for logical calculations.

Calls in the queue Calls in a queue are counted for the calculated periods during which they are
queued.

Calls on hold Calls on hold are counted for the calculated periods during which they are on
hold.

Reporting calculations
Maximum values and average calculations refer to the period under consideration in relation to the
resolution of the time axis. To calculate average statistical subtotals and totals, use the following
formula: Ø total = (Ø subtotal 1 + Ø subtotal 2 + Ø subtotal n) / n.

Misinterpretations
Average subtotals and totals are not calculated according to the following formula: Ø total =
(total of n individual values) / n .

Reporting calculations
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Example of how average values are calculated
The following example displays the calculation of the average ring time. If you divide the total ring
time by the total calls, the average value is 6.67. However, the Reporting module calculates the
average value of the individual average values and so the average is 6.25.

Period under
consideration

Counted and calculated are
totNNew <-RC totNConv <-RC totTRingAg <-RC Avg. Tring <-RC

10:00 to 11:00 2 1 15 7.5
11:00 to 12:00 1 1 5 5
Total 20 6.25

Number Minutes Minutes

Simple reporting calculation with one call
The assumptions and prerequisites are:

• Reporting will be created for a team with two agents.
• The period under consideration is from 10:00 a.m. to 11:00 a.m.
• The calculated period is set to 1 hour.
• The resolution of the time axis is set to “Total period of time”.
• During the period under consideration, the system processes one call.
• The conversation lasts for 30 minutes during the period under consideration. The call rings

from 10:20 a.m. to 10:25 a.m. The conversation starts at 10:25 a.m. and ends at 10:55 a.m.
Counters for simple reporting
Name Description
totNNew<-RC Number of calls
totNConv<-RC Number of conversations
totTRing<-RC Ring time
AvgTRing<-RC Average ring time
maxTRing<-RC Maximum ring time
totTConv<-RC Conversation time
maxTConv<-RC Maximum conversation time

Evaluations for the period under consideration from 10:00 a.m. to 11:00 a.m. are:

Period under
consideration

Counted and calculated are
totNNew <-
RC

totNCon v<-
RC

totTRi
ng <-
RC

AvgTR
ing<-
RC

maxTRi
ng<-RC

totTCon v<-
RC

maxTCo
nv<-RC

Table continues…
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10:00 to 11:00 1 1 5 5 5 30 30
Number Minutes

Advanced reporting calculation example with two calls
This example of reporting time calculation explains how to count ring times, calls, established
calls, established conversations, and conversation times.
The assumptions for this example are:

• Reporting will be created for a team with two agents.
• The period under consideration is from 10:00 a.m. to 12:00 p.m.
• The calculated period is set to 1 hour.
• The resolution of the time axis is set to “Total period of time”.
• During the period under consideration, the system processes two calls.
• The conversation lasts for 30 minutes during the period under consideration. The call rings

from 10:35 a.m. to 10:45 a.m. The conversation starts at 10:45 a.m. and ends at 11:15 a.m.
• The second call rings from 10:55 a.m. until 11:05 a.m. and the call is not answered.

Counters for reporting time calculation
Name Description
totNNew<-RC Number of calls
totNConv<-RC Number of conversations
totTRing<-RC Ring time
AvgTRing<-RC Average ring time
maxTRing<-RC Maximum ring time
totTConv<-RC Conversation time
maxTConv<-RC Maximum conversation time

Calculations for interval-based reporting
Period under
consideration

Counted and calculated are
totNNew
<-RC

totNCon
v<-RC

totTRing
<-RC

AvgTRing
<-RC

maxTRi
ng<-RC

totTCon
v<-RC

maxTCo
nv<-RC

10:00 to 11:00 2 1 15 7.5 10 15 15
11:00 to 12:00 1 1 5 5 5 15 15
10:00 to 12:00 2 1 20 10 10 30 30

Number Minutes

Consider how the average ring time (ØTRing<-) and the conversation time (totTConv<-) depend
on the period chosen for evaluation.
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Calculations for back office reporting
Period under
consideration

Counted and calculated are
totNNew
<-RC

totNCon
v<-RC

totTRing
<-RC

AvgTRing
<-RC

maxTRi
ng<-RC

totTCon
v<-RC

maxTCo
nv<-RC

10:00 to 11:00 2 1 20 10 10 30 30
11:00 to 12:00 0 0 0 0 0 0 0
10:00 to 12:00 2 1 20 10 10 30 30

Number Minutes

Counter verification
The counters that you can verify are based on the reporting method you are using.

• Interval reporting: You cannot verify the counters within intervals. You can only verify
counters of an evaluation for a total period and in the logical total.

• Back office reporting: You can verify the counters within intervals.

Counter types Formula
Counters for topic
reporting

Number of calls to the topic:

totNIncome = totNSucc + totNLost
totNNew + totNRr = totNConvAg + totNConvExtDest +
totNConvAutoAg + totNAban + totNRouted->
Number of topic calls routed to agents:

totNAg = totNConv + totNAbanAg
Number of topic calls routed to external destinations:

totNExtDest = totNConvExtDest + totNAbanExtDest
Counters for agent groups totN = totNNew + totNOverf<- = totNConv + totNAban +

totNOverf->
totNAban = totNAbanWait<=N + totNAbanWait>N<=M +
totNAbanWait>M
totNConv = totNConvWait<=N + totNConvWait>N<=M +
totNConvWait>M

Counters for agents totNNew<- + totNPickup<- = totNConv<- + totNAban<- +
totNPickup->
totNNew<- = totNNew<-RC + totNNew<-DCInt + totNNew<-
DCExt
totNConv<- = TotNConv<-RC + totNConv<-DCInt + totNConv<-
DCExt

Table continues…
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Counter types Formula
totNConvAg = totNConvWait<=N + totNConvWait>N<=M +
totNConvWait>M

Relationship among
different times

totTConv<- = TotTConv<-RC + totTConv<-DCInt + totTConv<-
DCExt
totTService<-RC = TotTConv<-RC + totTHold + totTWrap Up
+ totTForcedCWC

Note:

The formula is only valid when the agent under consideration is working
exclusively with incoming traffic.

totTHold and totTWrapUP count for incoming and outgoing traffic.

Email reporting
Emails can take longer to process than telephone calls. Therefore, you must provide the reporting
information during the email processing time.
No difference between interval-based and back office reporting: 
The interval-based and back office reporting are the same for email reporting. Counters are
provided for evaluation at the end of the interval. During this time, the system counts an event,
such as the arrival of a new email. Other counters that record the end of email processing are only
evaluated at the end of the processing period.
Availability of reporting counters: 
When emails are counted, you must take the calculated period into account.
For report evaluations, the period under consideration, which is the resolution of the time axis, and
the selected calculated period play an important role. This information applies to all calculations,
including the subtotal, total data, and exported data.
Maximum time to accept: 
The time to accept starts when an email arrives in the agent’s folder.
If the agent does not open the email before the maximum time for accepting is over, the workplace
is signed off from the distribution for all agent groups. After the maximum time to accept is
exceeded, the system redistributes the email according to the task flow set.
You can configure the maximum time to accept for topics.
Processing time: 
The duration between opening and closing an email is the processing time. Times when an agent
interrupts the active email or logs out are not counted as processing time.
Wait time: 
The duration between the arrival of an email in the agent’s Inbox and the time that the agent
opens the email is called the wait time.

Counter verification
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Service-oriented topic counter: 
Some reporting counters, such as handling time, service level, and Lost or Successful, are
important for the user. Irrespective of the actual history of an email, the selected topic is the most
important.
Handling time or processing time: 
The time between the arrival of an email in the system and the time when the agent completes the
email processing.

• Gross handling time: The total time between the arrival of an email and its completion.
• Net handling time: The time difference between the arrival of the email and its completion

minus the blocking time of the initial topic during this interval.
Number of emails from the point of view of the user: 
All emails that are completed by agents are counted as successful for the initial topic, that is
totNSucc, regardless of the topic by which the emails reached the agents.
For the initial topic, all emails are counted as definitively unprocessed, that is totNLost, if they
were deleted by an administrator, even if these emails have already been distributed through
several topics.
Email service factor: 
The net handling time is the calculation basis for the email service factor. The emails that are
deleted by an administrator are not taken into account.
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10:00 10:15 10:30 10:45

Time axis
Handling time (gross)

Handling time (net)

Blocking time

Email is received Email is completed

totNew
totNsucc or totNlost
totTHandlgross (+ avg, max)
totTHandlnet (+ avg, max)

E-mail service factor ESF

Topic counters for internal workflow: 
You can verify emails for individual intervals. The counters exist for the arrival and exit of emails at
the beginning and end of the interval.

Counter verification
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10:00 10:15

Time axis
totNDoneAgent
totNDoneExtern
totNTrans->
totNRouted->

totNProcln

totNnew

totNtrans<-

totNrouted<-
totNProcOut

totNDeleted

Evaluating reporting counters
About this task
Use this procedure to select the relevant reporting counters in the Configuration module.

Procedure
1. Open the Configuration ( ) module.

2. In the service menu, click Reporting Filters.

3. Select the relevant reporting counters.

4. Click OK.

Reporting operations
When you start the Reporting module, the File view is displayed. This view provides an overview
of existing reports and allows you to:

• Create new reports.
• Edit existing reports in the Inspector mode.

Reporting
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• View the resulting report in the work area.
The following sections provide procedures for working with reports. For more information, see
Avaya IP Office Contact Center Reporting Task Based Guide.

Viewing reports in the full screen mode
Procedure

1. Generate the report.

2. Click Full screen ( ).

3. To return to the normal view, click  again.

Renaming, deleting, and refreshing folders and reports
Procedure

1. Right-click a folder or report.

2. In the pop-up menu, do one of the following:

• To rename the folder or report, click Rename and type a name for the folder or report.

• To refresh and display the updated version of the folder or report, click Refresh.

• To delete a folder, click Delete and confirm your selection when prompted.

Changing the assignment of folders or reports, or both
About this task
Use this procedure to change the assignment of a folder. You can also change the assignment of
the reports within the folder.

Procedure
1. Right-click a folder or report.

2. In the pop-up menu, click Private.

The systems displays a padlock on the selected folder or report. If you selected a folder,
the system also displays a prompt.

3. At the prompt, click one of the following:

• Yes: To change the assignment of subfolders and reports within the folder.

• No: To change the assignment of only the folder.

Reporting operations
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Creating and editing a report
Procedure

1. To create a new report, do one of the following:

• In Reporting-File view, click New report.
• In the Reporting files area, right-click a report and click New > File.

2. To edit a report, do one of the following:

• Open the report and then click Edit.
• Right-click the report and then click Edit.

The system opens the report in the editable Inspector mode.

3. To edit the properties of the report, do the following:

a. Right-click the work area of the report and then click Properties.

b. Configure the properties for the report as described in Reporting properties field
descriptions on page 108.

4. (Optional) To update the basic data of a report, click Basic data.

For more information, see Configuring basic data from the Inspector mode menu on
page 112.

5. (Optional) To add an element, drag and drop it onto the work area of the report.

For more information, see Inserting and editing element properties on page 112.

Reporting properties field descriptions
Tab Option Description
General Name Enter a name for the reporting

file.
Size of work area You can customize the size

between 1280 and 6,000 points.
Description Enables you to enter a

description for the report.
Settings Grid Select this check box to display a

grid. You can define the width and
height of the grid using values
between 4 and 100 points.

Presentation Font Select an available font from the
drop-down menu. You can also
customize the font size, color, and
style.

Table continues…
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Tab Option Description
Line Select a line type from the drop-

down menu. You can also
customize the size and color of
the line.

Background You can:

• Select a background color.

• Upload a new background
image or delete an existing
image.

Generating reports manually
About this task
Use this procedure to generate a report manually. This procedure only applies if the considered
time frame is not in the past. If the time frame is set to the past, the report is generated
automatically.
The display number is restricted to ensure that the output is manageable. To manage the output,
reduce the reporting parameters, such as period, reporting counters, and objects.

Procedure
Right-click a report and, in the pop-up menu, click Generate.

You can also click Generate from the reporting work area.

The system displays  in the list of files indicating that the report is generated.

Generating automatic reports
About this task
You can configure automatic reporting at the time specified, with the specified cycle and output.
Automatic reporting can also calculate your time off. The evaluation of the report takes more time
than expected because many parameters are taken into account, such as large numbers of
counters or extensive periods.

Procedure
1. Open a report and click Edit.
2. Click Basic data and adjust the information in the Settings tab if required.

3. Click the Period tab and do the following:

a. Select Automatic reporting.

b. Set start and end dates and times.
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You can restrict the period to specific days. You can also select a monthly cycle or a
customized user-defined cycle. You can set the dates and times for the customized
cycle.

4. Click the Output tab and do the following:

a. In Export file, enter a file name.

b. In Output medium, select an output.

c. In Scheduler, enter the name of the computer on which the Reporting Scheduler
process is running.

5. To save your changes, click OK.

The system generates a report automatically at the specified time. Automatic reports are
stored in: C:\Documents and Settings\All Users\Application Data
\reporting data.

Exporting reports
About this task
You can export reports into the old or new view. The following formats are supported:

• PDF
• CSV
• RTF
• PNG
• Excel

Note:
• You can only use the old view to export a report into the RTF format. The new view does

not support this format.
• You can only use the new view to export a report as an image in the PNG format. The old

view does not support the image format. You also cannot use Internet Explorer to export
a report as an image.

• When a Contact Detail or Agent Status report is exported to the CSV format:
- Group count information is only displayed if you select the All pages check box.
- Elapsed time data is displayed based on desktop settings, such as your Windows

regional settings. An example of how elapsed time might be displayed is 0:00:00.

For more information about reporting limitations, see Avaya IP Office Contact Center
Reference Configuration.

Before you begin
Create and generate a report.

Reporting

April 2018 Using Avaya IP Office Contact Center for Windows 110
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows 


Procedure
1. Do one of the following:

• On the menu bar, click Export.
• Right-click the report and then click Export.

The system displays the Export Reports dialog box.

2. Enter the required data.

If you select Excel as the output format, you can configure an Excel macro to be used
when the report is exported. To use an Excel macro, enter the name of the Excel file in the
macro and the name of the macro.

3. Click OK when prompted.

The system exports the report in the selected format.

4. Click OK.

The files are stored in: C:\Documents and Settings\ All Users\Application
Data\reporting data.

Reporting elements and basic data
You can use elements to compile reports. You can also configure basic data for a report.

Element types
The following tables describe the two types of elements:
Elements used for labeling: 

Element name Purpose

Basic data ( ) To define general report data.

You can adjust the size of this element. You can also choose whether to
display names and data or only data.

Note:

In addition to the Basic data element, there is also a Basic data
button in the Inspector mode menu. For more information about this
basic data option, see Configuring basic data from the Inspector mode
menu on page 112.

Logo ( ) To use one or more logos in a report. You can adjust the size of the image
and assign a link to the image.

Table continues…
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Element name Purpose
Use one of the following image formats:

• *.bmp
• *.jpg
• *.gif
• *.png

Label ( ) To provide additional comments or labels for a report. You can adjust the
size of the label. You can use up to 256 characters.

Dividing line ( ) To add a horizontal line. You can change the line type, color, and width.

Elements that define report displays: 
Use the following elements to define how you want reporting data to be displayed. The options
are:

• Table ( )
• Pie chart ( )
• 3D pie chart ( )
• Line graph ( )
• Bar chart ( )

Inserting and editing element properties
About this task
Use this procedure to configure the properties of different elements.

Procedure
1. Drag and drop the required element onto the reporting work area.

2. Right-click the element and then click Properties.

3. In the Properties dialog box, complete the tabs.

For information about the available tabs for each element, see Properties tabs for elements
and basic data on page 113.

Configuring basic data from the Inspector mode menu
About this task
You can use basic data to create more than one table in a report with identical values. You need
not configure the values in each table individually because Table elements are populated with
basic data.
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Procedure
1. In the Inspector mode menu, click Basic data.

2. In the Basic data dialog box, configure the following tabs:

• Settings: For more information, see Settings tab field descriptions on page 114.

• Output: For more information, see Output tab field descriptions on page 116.

• Period: For more information, see Period tab field descriptions on page 115.

Properties tabs for elements and basic data
The following sections describe all the options available in the Properties dialog boxes for different
elements and for the Basic data option in the Inspector mode menu.

Display tab field descriptions
Option Purpose Impacted elements
Show data only Select this check box if you want to view data only. Basic data element
Presentation Select the information to be displayed. You can select

one or more of the following options:

• Date created

• Editor

• Period

Note:

The other options listed are not supported and
cannot be selected.

Presentation tab field descriptions
Option Purpose Impacted elements
Font Use this section to change the font size,

color, and format.
• Label

• Dividing line

• Basic data element
Background Select a background color. Label
Line Select the type of line you want.

You can also change the line thickness and
color.

Dividing line
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Image selection field descriptions
Option Purpose Impacted elements
File Select a file to upload.

You can insert one or more logos, adjust the size,
and assign a link to the logo.

Logo

Settings tab field descriptions
This tab is displayed in the Properties dialog box for elements and for the Basic data menu
option.

Option Purpose Impacted elements
Reporting name This option displays the name of the report. • Table

• Pie chart
• 3D pie chart
• Line graph
• Bar chart
• Basic data menu option

Do you want the
reporting to be
accessible by you
exclusively or by all
users in the system?

Specify whether you want the report to be
private or public.

Priority Specify the priority of the report. You can set
the priority between 1 and 9. The priority is
used for automatic reporting.

Select the type of a
reporting

Specify the type of reporting, depending on
the element. Examples of available options
include: Agents, Agent group, Dialer, and so
on.

Show alias only Select this check box to display only an alias.

When this option is selected, the agent name
is not displayed. If the agent has an alias
assigned, the alias is displayed. If no alias is
configured, an automatically-generated
pseudo name, such as “GeneratedAgent1”,
is displayed.

Basic data menu option

Use basic data period/
output only

Select this check box to eliminate period
definitions for the elements in the report. The
system uses the basic data period only for all
elements.

Note:

When you configure a report in the IP
Office Contact Center User Interface for
Windows, you must select the Use
basic data period/output only option
for the report to be displayed in the IP
Office Contact Center Web User
Interface.

Table continues…
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Option Purpose Impacted elements
Show counter name Select this check box to display a counter

name.
Use old Report Viewer
format

Select this check box if you want reports to
be exported in the old reporting view. If this
check box is not selected, reports will be
exported into the new view by default.

Period tab field descriptions
This tab is displayed in the Properties dialog box for elements and for the Basic data menu
option.

Option Purpose Impacted elements
Use settings
from basic data

Select this check box to use the default basic
data settings. If you change the basic data
settings, the time settings for the corresponding
statistics also change.

Note:

You cannot change the options described
below when this check box is selected.

• Table

• Pie chart

• 3D pie chart

• Line graph

• Bar chart

Start

End

Select a day for the start and end time frame.
You can change the month using the arrows on
the calendar.

You can also enter a start and end time to
generate hourly statistics automatically.

• Table

• Pie chart

• 3D pie chart

• Line graph

• Bar chart

• Basic data menu option

Restrict to You can limit the time frame to specific days of
the week, and you can also limit the time of day
for report data sampling.

• Days: You can select a day to generate a
report. The system displays the selected day
as dimmed. You cannot generate a report on a
day marked with a red diagonal line.

• Time periods: The table displays a beginning
and end time with a duration. You can edit the
time up to a maximum of one day starting from
12.00 a.m. to 11:59 p.m.

Automatic
reporting

You can specify a time and date for generating
reports automatically. Automatic reporting also
takes into account times when you are not
logged in.

You must define the following settings for
automatic reporting:

• Start date

Basic data menu option

Table continues…
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Option Purpose Impacted elements
• Start time
• Cycle

Output tab field descriptions
This tab is displayed in the Properties dialog box for elements and for the Basic data menu
option.

Option Purpose Impacted elements
Use settings
from basic
data

Select this check box to use the default
basic data settings.

Note:

You cannot change the options
described below when this check box
is selected.

• Table

• Bar chart

• Line graph

Resolution
of the time
axis

Define settings for the time-axis resolution.
You can select one of the following options:

• Months

• Weeks

• Days

• Total period

• User-defined

You can specify minutes and seconds for
the User-defined option.

• Basic data menu option

• Table

• Line graph

• Bar chart

Table view
Broken
down into:
Agent

Use this option to display all reporting
counters for agents.

• Basic data menu option

• Table

Broken
down into:
Time

Use this option to display counters
chronologically by date.

Technical
total

Select this check box to include all results of
a counter. The conversations or established
call counters exceeding the calculation
period are not filtered.

Logical total Select this check box to include individual
values for a mathematical calculation. If a
conversation continued for two calculation
periods, then it counts for both periods. In
contrast to the technical total, the logical
total refers to the survey period.

Reporting
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Counters tab field descriptions
Option Purpose Impacted elements
Available counters and Current
counters

Configure the counters to be
displayed. You can add counters
by moving them form Available
counters to Current counters.
You can also delete a counter, or
move counters up and down.

• Table

• Pie chart

• 3D pie chart

• Line graph

• Bar chartDescription Enter a description of the
reporting counter and the
counting method used. Each
counter consists of an
abbreviation, a name, and an
explanation.

View Select whether you want to view
names or abbreviations of
reporting counters.

• # indicates that a counter is
broken down into topics.

• * indicates that a counter is
broken down into agent groups.

You cannot use reporting
counters for each topic (#) or
each agent group (*) in a
graphical presentation.

Agent tab field descriptions
Option Purpose Impacted elements
Available elements and Current
elements

Configure the elements to be
displayed for agents and agent
groups. You can add an element
by moving it from Available
elements to Current elements.
You can also remove an element.

• Table

• Pie chart

• 3D pie chart

• Line graph

• Bar chart

Reporting elements and basic data
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Chapter 11: Agent status and contact detail
reports

In addition to the standard Reporting module, supervisors can also access the Agent Status Reports
and Contact Detail Reports modules. For more information, see Avaya IP Office Contact Center
Reporting Task Based Guide.

You can create or export reports in the following formats:

• PDF

• CSV

• Excel

Agent Status Reports module: 

Agent Status Reports provide a statistical evaluation of agent activities. You can use this module to
track when and how often agents sign in, sign out, and take breaks. You can also view presence
information and break times for one or more agents. In counter-based reports, you can only
evaluate presence and break times.

Contact Detail Reports module: 

Contact Detail Reports provide a statistical evaluation about all task types, which include Telephony,
Email, and Chat. This module provides information about callers, dialed topics, conversation
lengths, and agents involved with each task type. Counter-based reports provide only summary
values, such as the number of calls, number of conversations, total conversation times, and average
conversation times.

The following table summarizes the areas of application available with the Contact Detail Reports
module:

Option Description
Invoicing for customers (inbound) Invoicing is based on services rendered.
Reporting user processes This option provides information about:

• How customers communicate with the IP Office Contact Center
system.

• The topics and agents that are involved.

• How long customers communicate and with whom.
Detailed task type processes Processes are broken down by task type for each IP Office Contact

Center agent.
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Agent status report data
The following table describes all possible agent status report data. The UI does not display all of
this data by default. To modify the data that is displayed, you can click on the column header, and
then from Columns, select the data that you want to see.

Column name Description
Agent name Displays the name of the agent associated with the agent activity.
Start time stamp Displays the date and time. The system records all agent activity with a time stamp.
Login/logout Specifies whether the agent is logged in or out of the system regardless of the task

type.
Sign on/sign off Specifies whether an agent is signed in or out of an agent group.

Note:

Agents are also signed out if they do not answer a call, email, or IM within the
configured timeout period. In this case, Sign on/sign off displays Sign Off
(RONA) for the agent.

Break Time Specifies whether an agent is on a break.

If the agent takes a break and signs out of an agent group, Break Time on is
displayed. If the agent signs in after the break, Break Time off is displayed.

Wrap Up without
call

Specifies the status of manual wrap-up time, which is started by the agent manually
and is independent of a call.

Additional info Displays additional information when an activity starts.
Task type Displays the task type.

Contact detail report data
The following table describes all possible contact detail report data. The UI does not display all of
this data by default. To modify the data that is displayed, you can click on the column header, and
then from Columns, select the data that you want to see.

Column name Description
Voicemail is
recorded

Specifies whether the contact started with a voice mail message being recorded.

The report can display the following options:

• Yes: Contact begins with recording a voice mail message.

• No: Other.
Contact type Displays how the contact was established with the customer. The options are:

Dialer, ACD, or Other.
Start time stamp Displays the contact start time stamp.

Table continues…
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Column name Description
Total duration (s) Displays the duration of the call in seconds. This excludes the wrap up time.
Total duration with
ACW (s)

Displays the duration of the call in seconds, including the wrap up time.

End time stamp Displays the date and time when the contact was recorded as complete. This
excludes the wrap up time.

End time stamp
with ACW

Displays the date and time when the contact was recorded as complete. This
includes the wrap up time.

Task type Displays the task type.
Caller/Sender Displays the caller number, email address, or chat ID.
Selected address Displays the telephone number, email address, or chat ID that is selected by the

caller.
Original topic Displays the name of the topic that first handled the caller.
Initial Interaction Displays the initial contact connection status with the following details:

• ConnectedDirect: Connected without a queue.

• ConnectedQueued: Connected with a queue without an announcement.

• ConnectedQueuedAnnounce: Connected with a queue and an announcement.

• DroppedOverload: Disconnected by the system due to overload.

• DroppedBusy: Disconnected by the system because the system is busy.

• DroppedCanceled: Disconnected by the system by a call flow.

• AbandonedAlerting: Disconnected by the caller during a call.

• AbandonedQueued: Disconnected by a caller in the queue without an
announcement.

• AbandonedQueuedAnnouncement: Disconnected by a caller in the queue
with an announcement.

• Callback: Call back according to the queue position.

• Rejected: Wrong number dialed by an agent for an outgoing topic call.
Number of
customer records

Displays the number of customer records that were matched with the caller using
the customer configuration.

Interaction time (s) Displays duration of the call, email or chat conversations in seconds. This
excludes the time when the call was on hold.

Hold time (s) Displays the total hold time in seconds.
Wait time (s) Displays the total waiting time in seconds. This includes the time spent on IVR,

ringing, and queue.
Alerting time (s) Displays the total time in seconds spent on call ringing, chat, and email alerts at

the destination.
Queue time (s) Displays the total time in seconds spent on IVRs and announcements.

Table continues…
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Column name Description
Number of
customer records

Displays the number of connecting legs that define the contact.

Number of
customer
connections

Displays the number of connecting legs, which have an established connection
with the customer.

Chargeable time (s) Displays the total time in seconds spent to complete a call on a chargeable
number.

Number of
consultations

Displays the number of consultations or transfers that define the contact.

Number of
consultation calls

Displays the number of consultation calls or supervised transfers that define the
contact.

Consultation
speech time

Displays the total time spent on consultation calls. This excludes the hold time.

Wrap up time (s) Displays the time in seconds spent on completing the post call work.
Direct topic dial in
contact

Specifies whether the subscriber selected the topic. Also, indicates whether the
contact was inbound or outbound.

External contact Specifies whether the contact is external or internal.
Inbound contact Specifies whether the contact is inbound or outbound.
OutCC contact Specifies whether the contact is an outgoing call center call.

The report can display the following options:

• Yes: Contact was an outgoing call center call.

• No: Other.
Dialer contact Specifies whether the contact is established using the Dialer functionality.

The report can display the following options:

• Yes: Contact established using dialer.

• No: Other.

Additional details
You can click  in the new viewer or  in the old viewer to view additional details.
The following additional details are provided:

Type of information Details displayed
Connections information • Details

• Start time stamp

• Caller/Sender

• Caller/Sender Name
Table continues…
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Type of information Details displayed
• Customer number

• Customer priority

• Selected address

• First topic

• Last topic

• Task type

• Initial Interaction (connection status)

For more information about initial interaction connection status details,
see Initial Interaction on page 120.

• Call time

• Speech or active time

• Wait time

• Time on hold

• Chargeable time of connection

• Wrap up

• Consultation

• Routed

• Voicemail is recorded

• Dialer contact

• Network overflow
Topic Information • Start time stamp

• Topics

• Destination name

• Wait time

• Announcement

• Announcement script

• IVR script

• Welcome announcement
Destination Information • Start time stamp

• Destination name

• Destination

• Destination type

• Agent group
Table continues…
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Type of information Details displayed
• Topics

• Wait time

• Ring time

• Speech-/active time

• Time on hold

• Wrap up

• Job Codes

Contact detail report data
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Appendix A: Resources

Documentation
The following IP Office Contact Center documents are available on the Avaya Support website at 
http://support.avaya.com.

IP Office Contact Center User Interface for Windows documents
Document title Use this document for Audience
Administering Avaya IP Office
Contact Center Address Books

Administer address books in the
IP Office Contact Center
interface. The address book
feature simplifies agent tasks
such as making calls and sending
emails.

Administrators

Using the Avaya IP Office Contact
Center Configuration and User
Interface Configuration Modules

Perform administration tasks with
the Configuration and UI
Configuration modules.

Note:

This document is also
available as a help system
through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Dialer

Work with the Dialer module in
the IP Office Contact Center
interface.

Note:

This document is also
available as a help system
through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center IVR Editor

Create and edit IVR editor scripts.

Note:

This document is also
available as a help system

Administrators

Table continues…

April 2018 Using Avaya IP Office Contact Center for Windows 124
Comments on this document? infodev@avaya.com

http://support.avaya.com/
mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows 


Document title Use this document for Audience

through the product
interface.

Administering Avaya IP Office
Contact Center Task Flow Editor

Create and edit task flow editor
scripts. As of Release 10.0, this
document also contains the task
tag information that was
previously in a separate IP Office
Contact Center Task Tags
Reference document. The
separate document has been
discontinued.

Note:

This document is also
available as a help system
through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Text Blocks

Create, edit, and administer text
blocks for the IP Office Contact
Center email feature.

Administrators

Using Avaya IP Office Contact
Center for Windows

Use the IP Office Contact Center
User Interface for Windows.

Note:

This document is also
available as a help system
through the product
interface.

All interface users, including
agents, supervisors, and
administrators.

Other related IP Office Contact Center documents
Document title Use this document for Audience
Avaya IP Office Contact Center
Feature Description

Understand IP Office Contact
Center features and capabilities.

All users

Avaya IP Office Contact Center
Reference Configuration

Understand IP Office Contact
Center deployment topologies,
network architecture, system
capacities, product
interoperability, and functional
limitations of specific
configurations.

• Sales and support personnel

• Architects

• Implementation engineers

Addendum to Avaya IP Office
Contact Center Task Based
Guides

The Task Based Guides (TBGs)
are not being updated in this
release. This addendum is an
add-on to the existing TBGs. The

• Support personnel

• Implementation engineers

• Administrators
Table continues…
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Document title Use this document for Audience
addendum only includes new
Release 10.1.2 content. It does
not replace the existing TBGs.
Use the addendum in
combination with the following
existing Release 10.1 and
Release 10.1.1 TBGs:

• Avaya IP Office Contact Center
Core Installation Task Based
Guide

• Avaya IP Office Contact Center
Advanced Installation Task
Based Guide

• Avaya IP Office Contact Center
Maintenance Task Based Guide

• Avaya IP Office Contact Center
Telephony User Interface
Configuration Task Based
Guide

• Avaya IP Office Contact Center
Dialer Task Based Guide

• Avaya IP Office Contact Center
Task Flow Editor Telephony
Task Based Guide

• Avaya IP Office Contact Center
IVR Editor Scenarios Task
Based Guide

• Avaya IP Office Contact Center
Email and Chat Services Task
Based Guide

• Avaya IP Office Contact Center
Reporting Task Based Guide

• Configuring Call Recording for
Avaya IP Office Contact Center

Note:

The Release 10.1.1 TBGs
are in English only.

Resources
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Finding documents on the Avaya Support website
Procedure

1. Navigate to http://support.avaya.com/.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select an appropriate release number.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list
displays the documents only from the selected category.

7. Click Enter.

Training
You can access training courses and credentials at http://www.avaya-learning.com. To search for a
course, after logging in to the website, enter the course code or the course title in the Search field
and press Enter or click >.

Table 1: IP Office Contact Center courses and certification credentials

Course code Course title
ACDS-3782 Design — Avaya IP Office Contact Center
ACIS-7750 Implementation — Avaya IP Office Contact Center
ACSS-7894 Support — Avaya IP Office Contact Center

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Training
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Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you
can access the Knowledge Base without extra cost. You must have a login account and a valid
Sold-To number.

Resources
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Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya user ID and password.

The system displays the Avaya Support page.
3. Click Support by Product > Product Specific Support.
4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.
6. Click the Technical Solutions tab to see articles.
7. Select relevant articles.

Support
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Glossary

After Call Work An agent state consisting of work related to the preceding Automatic Call
Distribution (ACD) call. After Call Work (ACW) is also accessible by a
button on the set of the agent and does not have to be related to an ACD
call.

Automatic Call
Distribution

A programmable feature at the contact center. Automatic Call Distribution
(ACD) handles and routes voice communications to queues and available
agents. ACD also provides management information that can be used to
determine the operational efficiency of the contact center.

Counters A component used to calculate durations, intervals, the number of events,
or the number of objects. Each IP Office Contact Center counter has a
unique name.
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